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As forward biasing current increases, the impedance decreases to a low level. Therefore, the RF 
level of the signal applied to Q6 increases as the bias current from the power control circuit 
increases. 

5.2.2.2 PA RF DEVICE (Q6) 

Impedance matching for Q6 is provided by several capacitors, inductors, and sections of 
microstrip. Q6 is an N-channel enhancement mode lateral MOSFET. The bias voltage (which is 
required for the device to turn on) is controlled by the transmit signal. It is applied to the gate and 
controlled by the logic through shift register U1. Therefore, this device is turned off in the receive 
mode which improves isolation. Several capacitors, inductors, and resistors isolate this supply 
from RF. Likewise, the 13-volt RAW BAT supply applied to the drain is isolated by similar 
components. 

From the output of the variable attenuator, the signal is fed to Q6. Q6 operates as a single-ended 
device. It produces an output power of up to 35 watts. 

5.2.2.3 FORWARD POWER DETECTOR, ANTENNA SWITCH, 
LOW-PASS FILTER 

The power control circuit senses Q6 output power to control the power output. A directional 
coupler senses the forward power signal. This signal is then rectified by CR8 and applied to the 
power control circuit. This signal is a DC voltage that increases in proportion to the level of 
forward power. Refer to Section 5.2.2.4 for more information on power control. 

PIN diodes CR9, CR11, CR12, and CR15 form an antenna switch that switches the antenna to the 
transmitter in the transmit mode and the receiver in the receive mode. As stated in Section 
5.2.2.1, PIN diodes have very high impedance when in the off mode and very low impedance 
when forward biased. Transistors Q7 and Q9 are on in the transmit mode and off in the receive 
mode. 

In the transmit mode all four diodes are forward biased. The transmit signal then has a low 
impedance path through CR9 to the low-pass filter and is blocked from the receiver by a 
grounded quarter-wave line formed by C64, L15, and C66. A grounded quarter-wave lines 
presents very high impedance at the non-grounded end. PIN diodes CR11 and CR15 and a second 
quarter-wave line formed by C76, C77, and L17 provide additional isolation. 

In the receive mode, all four diodes are in the off mode. Therefore, the receive signal from the 
antenna is blocked from the power amplifier by CR9 and has a low impedance path through L15, 
C74, L17, and C67 to the receiver in the RF module. 

From the antenna switch the RF signal is applied to a low-pass filter formed by L11-L13 and 
several capacitors and sections of microstrip. This filter attenuates harmonic frequencies above 
the transmit band that could cause adjacent channel interference. R53 dissipates static buildup in 
the antenna. 

5.2.2.4 POWER CONTROL 

Introduction 
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The power control circuit maintains a constant power output as changes occur in power amplifier 
temperature and voltage. It does this by sensing forward power and then varying the drive to Q6 
to maintain a constant output power. The drive to Q6 is controlled by varying the voltage applied 
to the variable attenuator circuit described in Section 5.2.2.1. In addition, the current applied to 
final amplifier Q6 is sensed, and if it becomes excessive, power is cut back to a low level. 

The power output level is set in 127 steps by a Digital-to-Analog (D/A) converter formed by shift 
register U1 and several resistors. This converter is controlled by the microcontroller to provide 
the following functions: 

• It allows the RF power output level to be adjusted using the PCTune™ software. 

• It allows the microcontroller to cut back power if the power amplifier temperature sensed by 
thermistor TR1 becomes excessive. 

• It allows high and low power levels to be selected by the user or to be fixed by programming 
using the PCConfigure™ software.  

Forward Power Sense 

The forward power signal from the directional coupler is applied to pin 2 of amplifier U2-A. This 
is a DC signal that increases proportionally to forward power. The other input to U2-A on pin 3 is 
a DC reference voltage from the D/A converter. This signal sets the power output of the 
transmitter. 

U2-A is a difference amplifier which amplifies the difference between the reference voltage on 
pin 3 and the forward power signal on pin 2. The turn-on time of U2-A is controlled by the time 
constant of C17 and R28, and negative AC feedback to prevent oscillation is also provided by 
C17. 

This circuit operates as follows: Assume the output power attempts to increase. The DC voltage 
applied to U2-A, pin 2 then increases which causes the output voltage on pin 1 to decrease. 
Transistors Q1 and Q2 then turn off slightly which decreases the supply voltage to the variable 
attenuator circuit. The input power to Q6 then decreases. The Q10 output power then decreases to 
maintain a constant power output. R26 and R24 limit the voltage gain of Q2 and Q1 to 
approximately two volts. 

Delayed PTT 

Transistor Q3 is used to delay power output for a short time after the transmitter is keyed. This 
allows the synthesizer and exciter to stabilize so that the transmitter does not transmit off 
frequency. The signal which controls Q3 is from microcontroller on the logic board. In the 
receive mode this output is low, so Q3 is off. Pin 2 of U2-A is then pulled high by the 8-volt 
supply applied through R29 and CR1. This causes the output on pin 1 of U2-A to go low which 
shuts off Q2 and Q1. Then when the transmitter is keyed, after a short delay Q3 then turns on and 
diode CR1 is reverse-biased. Only the forward power signal is then applied to pin 2 of U2-A. 

Over-Current Shutdown 

Current to Q6 is monitored by sensing the voltage drop across R33. Pins 3 and 6 of U3 are 
connected across this resistor. As current increases, the output voltage on U3 pin 8 increases. This 
voltage is applied to Schmitt trigger U2-B. When the voltage on pin 6 rises above the reference 
on pin 5, the output on pin 7 goes low. This lowers the voltage applied to U2-A, pin 3 which 
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lowers the power control voltage to the variable attenuator. This results in lowering the power 
output to approximately 25% of full power. 
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SECTION 6 ALIGNMENT PROCEDURE 
 
 

6.1 GENERAL 

6.1.1 INTRODUCTION 

The following alignment procedure should be performed if repairs are made that could affect the 
factory alignment or if adjustments may have changed for some other reason. To verify radio 
operation, the performance tests in Sections 6.5 and 6.6 can be run. To perform transceiver 
alignment, the following are required: 

• PC-compatible computer 

• Remote Programming Interface (RPI), Part No. 023-5300-000.  

• PCTune software, Part No. 023-9998-499. 

All adjustments are set digitally using the computer. Therefore, there is no need to disassemble 
the transceiver to access adjustment points. In addition, audio test signals are generated internally, 
so an audio generator is not required. The required test equipment is shown in Figure 6-1. 

 

6.1.2 TUNE SOFTWARE 

General 

The PCTune software is a Windows® program. Minimum software and hardware requirements 
are as follows: 
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• Windows® 95/98/NT/2000 (3.1 cannot be used) 

• Pentium® processor or equivalent 

• 16 MB of RAM 

• A hard disk drive with at least 3 MB of free space 

• A CD-ROM drive 

• An available serial port 
 

Software Installation 

Proceed as follows to install this software: 

1. Close all applications that are currently running (other than Windows). 

2. Insert the CD-ROM containing the PCTune software into the drive. 

3. From the Windows taskbar, choose RUN and open SETUP.EXE on the drive being used. 
Alternatively, use File Explorer and double click SETUP.EXE. 

4. Follow the instructions on the screen. The program is automatically loaded on the hard drive 
and startup shortcuts or groups are created. 

Starting PCTune 

Select Start in the taskbar, then Programs > PCTune > PCTune. 

Exiting PCTune 

Select File > Exit or click the button. 

Online Help 

Online help is not available. 

6.1.3 PCTUNE VERSION REQUIRED 

PCTune, Version 2.0.0 or later is required to tune the RF board. The version number can be 
displayed by selecting the Help > About menu. 

6.2 MAIN SCREEN 

The main PCTune screen is shown in Figure 6-2. Information on the various parts of this screen 
follows: 
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Menu Bar - Used to select the menus described in Sections 6.3.1-6.3.5. 

Tool Bar - These buttons are used to quickly select functions as follows: 

- Displays the screen used to set serial port parameters (see Section 6.3.3). 
 

- Selects the Partial Tune mode the same as  the Transfer > Tune Partial menu (see Section 
6.3.3) This mode allows manual selection of the desired Tune Category and then automatically 
steps through the various settings for that adjustment.  

- Selects the Edit Mode which allows parameters in the selected screen to be changed without 
stepping through each adjustment.  

- Reads and displays the current parameters programmed in the radio the same as the Radio > 
Read Tune Parameters menu (see Section 6.3.3). 

 - Writes the current tune parameters to the radio the same as the Transfer > Write Tune 
Parameters menu (see Section 6.3.3). This occurs automatically when a Partial Tune adjustment is 
completed.  

- Exits the current Tune Category without writing parameters to the radio.  
 
Radio Information  

When tuning parameters are read from a radio by clicking the  button or selecting the Transfer 
> Read Parameters menu, the following information is displayed in the top part of the screen:  

Type - The Radio Series selected by the Radio menu (see Section 6.3.2). The correct series must 
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be selected for communication with the radio to occur.  

Band - The radio frequency band of the radio displayed after information is read from radio. Do 
not select the band using Tools > Set Band (Section 6.3.4) because this may make the radio 
nonfunctional.  

Software DSP - The first number is the version number of the radio firmware (Flash/operating 
code), and the second number is the version number of the DSP software.  

ESN - The Electronic Serial Number electronically stored in the radio.  

Tuning Categories  

These buttons select the tuning adjustment to be performed. Different functions are 
displayed for the 51xx and 53xx. If the Partial tune mode is selected, these buttons select the 
particular adjustment that is performed.  

Mode/Tool Tip  

Information on the bottom line of the screen indicates the current tune mode and information 
on the selected button on other information.  

6.3 MENU BAR DESCRIPTION  

6.3.1 FILE MENU  
Selecting File > Exit closes the PCTune program.  

6.3.2 RADIO MENU  
[Insert 4300 radio menu] 

The Radio menu shown above selects the radio type. [Insert correct selections for 4300] The 
correct radio type must be selected for communication with the radio to occur.  

6.3.3 TRANSFER MENU  

 

COM Ports - Displays the following screen which selects the serial port (1-12) and baud rate 
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(9600/ 19200) used for communication with the radio. Select the computer port to which the test 
cable is connected (see Section 6.4.1), and 19200 baud is normally selected. These parameters 
default to the last selected condition the next time the program is started.  

 

Read Tune Parameters - Selecting this function or clicking the  button reads the tune 
parameters currently programmed in the transceiver and displays them in the various screens.  

NOTE: Values in the various screens are for reference only and adjustments should be done only 
by using the Partial Tune function.  

Write Tune Parameters - Selecting this function or clicking the  button writes the current 
tune parameters to the radio. This occurs automatically when a Partial Tune adjustment is 
completed.  

Tune Complete – Not available. This function automatically steps through all the tests required 
to tune the radio.  

Tune Partial - Selecting this function or clicking the  button selects the Partial Tune mode. 
This mode automatically steps through all the adjustments of the currently selected Tune 
Category.  

6.3.4 TOOLS MENU  
 

 

Reset Radio - Resets the radio control logic similar to cycling power. This can be used, for 
example, to change the radio series or band or exit an adjustment before it is complete.  

Set Band - Selects the operating band of the radio. All tuning values are reset to the factory 
defaults.  
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CAUTION: Do not select this function because it can make the radio non-functional.  

Reset Passwords - Erases all password information contained in the radio. This function can be 
used, for example, to allow reprogramming of passwords if they are lost. NOTE: Radio 
personality information is not erased by this function.  

Erase EEPROM  

CAUTION: This function erases important radio programming information as described 
below.  

Complete -Erases all EEPROM information, including factory programmed parameters.  

CAUTION: Do not select this function because the radio must be returned to the factory to 
make it operational again.  

Parms Only - Erases all personality information.  
NOTE: The radio must be reprogrammed after this function is selected.  

Tx/Rx Tests - Selects a screen which is used to check digital (Project 25) receive and transmit 
performance. Refer to Section 6.5 for more information.  

Restore Rx Front End Parameters - Programs the radio with default receive front end tune 
parameters. Other parameters remain unchanged.  

6.3.5 HELP MENU  
Displays the version number of the PCTune software and other information.  

6.4 TUNING PROCEDURE  

6.4.1 CONNECTING TEST SETUP  

1. With transceiver power turned off, connect the RPI to an unused serial port of the 
computer using a suitable cable (see Section 4.1.3).  

2. Connect the RPI to the microphone jack of the transceiver using programming cable, Part 
No. 023-5300-005 (see Figure 6-1).  

3. If the receiver squelch adjustment will be made, connect a SINAD meter to the Speaker 
Audio Out jack on the RPI (see Figure 6-3). This is a low level fixed audio output, and a 2.6 mm 
(3/32”) phone jack is used. 
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Figure 6-3  RPI Front Panel  

4. Connect a wattmeter and a suitable load to the antenna jack of the transceiver for the 
transmitter tests. For the receiver tests, connect the signal generator to the antenna jack through a 
6 dB or greater isolation pad. 
 
 

6.4.2 STARTING AND CONFIGURING PCTUNE  

1. Start the program as described in Section 6.1.2 and turn transceiver power on. Select 
Transfer > COM Port and make sure that the correct serial port and the 19200 baud rate are 
selected (see Section 6.3.3).  

2. Select the Radio menu and make sure the correct radio series (43xx) is selected [What is 
the correct menu selection?] (see Section 6.3.2).  

3. Select Transfer > Partial Tune and click the button for the desired Test Category.  

4. Follow the instructions displayed on the screen to complete the various adjustments 
required for a particular setting. Then repeat for other applicable Test Categories.  

6.5 DIGITAL PERFORMANCE TESTS  

6.5.1 GENERAL  
This section describes how to check the performance of the radio on digital Project 25 

channels. The PCTune software includes a Tools > Tx/Rx Tests menu that displays the screen 
used for these tests.  

• To perform these tests, a Digital Communication Analyzer such as Motorola R2670 or 
IFR 2975 is required. 

• These tests follow the TIA-102-CAAA-A “Digital C4FM/CQPSK Transceiver 
Measurement Methods” specification. Refer to that document for more information. 

• A P25 conventional channel preprogrammed by the PCConfigure software is used for 
testing. The PCTune software does not select a specific test channel. The test channel 
must be programmed with the following options: 
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NAC - 293 (hex)  
TGID (Talk Group ID) -1  
Frequency - Any frequency in radio operating band  

6.5.2 RECEIVE TEST SETUP  
1. Connect the test setup and start and configure the PCTune software as described in Section 6.4. 

Select the Tools > Tx/Rx Tests menu to display the Tx/Rx Tests screen. Then in the Test Type 
drop-down list select Receive to display the following screen.  

 

2. Connect the Digital Communication Monitor to the antenna jack using a 6 dB or greater 
isolation pad. Set the Monitor output for the “1011” test pattern.  

6.5.3 RECEIVE SENSITIVITY TEST  
1. A tone should be heard from the radio speaker if the analyzer is set properly. Select the 
“Short” or “Long” test in the Test drop down list and the radio should mute.  

2. Set the analyzer output level for 0.35 µV (–116 dBm) at the receiver antenna jack. The 
Bit Error Rate (BER) should be 5% or less. (This is a ratio of the receive bit errors to the total 
number of bits transmitted.)  

3. Increase the analyzer output level to 1000 µV (–47 dBm). The BER rate should be less 
than 0.01%. This is the BER Rate Floor.  
 

6.5.4 TRANSMITTER TESTS  
1. If applicable select the Tools > Tx/Rx Tests menu to display the Tx/Rx Tests screen. 
Then in the Test Type drop-down list select Transmit to display the following screen. Connect a 
dummy load to the radio antenna jack. Monitor the transmit signal with the Digital 
Communication Monitor.  
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2. Select the Low Deviation test and set the analyzer as required to measure transmitter 
deviation. This test generates continuous repetitions of bits 10100000. Deviation should be 848-
1037 Hz.  
3. Click the “PTT” button to transmit the tone. When finished, click that button again to 
turn the transmitter off.  
4. Select the “High Deviation” test which transmits a standard transmitter test pattern. 
Deviation should be 2544-3111 Hz.  
5. The “1011 Hz” test transmits a standard 1011 Hz tone similar to that used for the receiver 
test. This tone can be used to check the operation of other radios.  
6. The “Silence” test transmits a standard silence test pattern which produces no receive 
audio output by the receiving radio. This tone can also be used to test other radios.  
7. Select “Normal” to transmit a standard voice signal by speaking into the radio 
microphone.  
 

6.6 ANALOG PERFORMANCE TESTS  

6.6.1 GENERAL  
The PCTune software is not used for analog channel performance testing. Simply program 

the desired channels using the PCConfigure software as described in Section 4. The RPI is still 
required to monitor the audio output signal from the radio.  

Depending on the application, 12.5 kHz and 25 kHz test channels may need to be 
programmed. Also, test channels programmed with or without Call Guard

®

 (CTCSS/DCS) 
squelch control may be required.  

6.6.2 RECEIVER PERFORMANCE TESTS  
1. Connect a signal generator to the antenna jack using a 6 dB or greater pad. Set the output 

for the channel frequency, modulated with 1 kHz at the following deviation:  
12.5 kHz Channels - 1.5 kHz 
25 kHz Channels - 3.0 kHz 
 

2. Connect a SINAD meter to the receive audio jack of the RPI (see Figure 6-3) This is a 
low level fixed audio output.  

SINAD Sensitivity  
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3. Set the signal generator output level for 1000 µV (–47 dBm) at the antenna jack.  

4. Decrease the signal generator output to obtain 12 dB SINAD. The signal generator output 
should be 0.35 µV (–116 dBm) or less for 25 kHz channels, or 0.50 µV (–113 dBm) or 
less for 12.5 kHz channels.  

 

Audio Power Output and Distortion  

5. Connect a distortion meter across the speaker load. Return the generator output to 1000 
µV. Distortion should be 3% or less.  

Squelch Sensitivity  

6. Increase the signal generator output from zero and note the SINAD when unsquelching 
occurs. It should be approximately 8 dB.  

 

6.6.3 TRANSMITTER PERFORMANCE TESTS  
1. Connect a wattmeter and dummy load to the antenna jack. Monitor the transmit signal 

with a communication monitor.  

Transmit Frequency  

2. Monitor the transmit frequency and at room temperature it should ±100 Hz. At other 
temperatures [–22° to +140° F (–30° to +60° C)], it must be within 2.5 PPM. This also 
checks the receive frequency.  

 

Transmit Power  

3. Transmit power should be in the following ranges. High and low levels can be preset 
anywhere in this range by PCTune. The factory default for high power is the maximum 
shown below, and low power is half that value.  
Standard Models -10-50 Watts 
 

Transmit Modulation  

4. Monitor the transmit modulation with a modulation meter. Speak into the microphone 
with a normal voice. Modulation should be approximately as follows with no 
CTCSS/DCS signaling present:  
12.5 kHz Channels - 1.4 kHz 
25 kHz Channels - 3.4 kHz 
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5. Select a channel programmed with Call Guard (CTCSS/DCS) signaling. Maximum total 
Call Guard and voice modulation should be approximately as follows:  
12.5 kHz Channels - 2.3 kHz  
25 kHz Channels - 4.7 kHz 
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SECTION 7 PARTS LIST 
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SECTION 7   PARTS LIST 

Ref No. Description Part No.

   

 CHASSIS, HARDWARE, 
AND MISCELLANEOUS  

A 200  Interface board assembly 
(see separate listing which 
follows) 

023-5500-200

A 300  Receiver/exciter assembly 
(VHF) 
(see separate listing on 
pageTBD) 

023-5517-212

 Receiver/exciter assembly 
(UHF) 
(see separate listing on page 
TBD) 

023-5567-212

A 301  Accessory pigtail cable 
(internal)  

597-2002-230

A 302 Remote/acc pigtail cable 
(internal) 

597-2002-249

A 303 Remote pigtail cable (internal
for second control unit) 

597-2002-251

A 400  Logic board assembly 
(see separate listing on page 
TBD) 

023-5500-600

A 500  VHF 50W PA bd assy 50W 
mod. 
(see separate listing on page 
7-Error! Reference source 
not found.) 

023-5315-531

  UHF 40W PA bd assembly 
(see separate listing on page 
7-Error! Reference source 
not found.) 

023-5365-501

A 810  Front panel assembly (frt mt) 
(see separate listing on page 
7-) 

023-5300-810

     

CH 101 Chassis, std VHF models 015-0970-001

 Chassis, std UHF models 015-0970-002

EP 001  No. 6 terminal lug  586-0005-106

EP 002  Ferrite bead, .375 x .375  517-2002-003

EP 003 Ferrite block (for J200) 517-2002-020

EP 920 Snubber, bot shield for 018-1134-136

encryp mod 

   

HW 
001  

Captive screw, cover  537-9007-045

HW 
002  

Screw, 6-32 x 5/16 Torx  575-0006-010

HW 
003  

Plug, option (in unused chass 
hole) 

032-0792-075

HW 
004  

Audio amp U1 clip  017-9700-001

HW 
005  

O-ring, 1/8 x 1/4 cover screw 574-2002-001

HW 
006  

Nylon washer, cover screw 596-4408-015

HW 
007  

Split rubber grommet 1/8ID  574-0002-015

HW 
009  

Flat washer, cover screw 596-9408-009

HW 
010  

Screw, 4-40 x 5/16 phil pan 
hd  

575-0604-010

HW 
011  

Washer, No 4 split lock 596-1304-008

HW 
012  

Washer, No. 4 split lock  596-1304-008

HW 
020  

1/4 x 1.20 x 1.90 urethane 
pad 

018-1007-250

HW 
150  

Screw, 4-40 x 5/16 phil pan 
hd  

575-0604-010

HW 
151 

Screw, 6-32 x 3/8 phil flat hd 575-8206-012

HW 
152 

Screw, 8-32 x 3/8 hex socket 
hd 

575-9076-012

HW 
202  

Screw, 4-40 x 1-1/8 mach 
pan hd  

575-1604-036

     

J 002  RF – PA board connector  515-9006-110

J 200 Connector, 28-pin inline 
header 

515-7181-038

     

MP 002 Cover, top black  015-0970-007

MP 003 Cover, bottom black  015-0970-009
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MP 004 Gasket, blank front panel 
(remote) 

032-0792-068

MP 005 Front panel, blank (remote) 032-0792-005

MP 156 Gasket, top cover  018-1136-136

MP 157 Gasket, bottom cover  018-1136-134

MP 300 Foam tape, dbl side  574-3002-013

MP 505 Grounding clip (rx/ex assy) 017-9700-003

MP 601 Shield, low-pass filter wrap 
around 

017-9700-010

MP 602 Cover, low-pass filter cover 017-9700-011

   

NP 001 Label, RS 5300 559-5300-100

NP 002 Label, EFJohnson 559-9001-310

   

W 103 Cable assy, display - logic bd 023-5300-025

W 110 Interface pigtail, motorcycle F 
DB25 

597-2002-280

W 501  Pwr pigtail cable assembly, 
std PA 

597-2002-235

W 502  RF pigtail cable assembly, 
std PA 

597-2002-240

 INTERFACE BOARD 
Part No. 023-5500-200 

C 002  470 µF 25V electrolytic  510-4064-471

C 003  100 µF 25V electrolytic  510-4425-101

C 004  1.0 µF 10V tantalum smd  510-2624-109

C 005  .1 µF ±5% X7R 50V cer smd 510-3609-104

C 006  .1 µF ±5% X7R 50V cer smd 510-3609-104

C 007  .1 µF ±5% X7R 50V cer smd 510-3609-104

C 009  470 pF ±5% NPO cer smd  510-3602-471

C 010  .1 µF ±10% X7R 50V cer 
smd  

510-3606-104

C 011  .1 µF ±10% X7R 50V cer 
smd  

510-3606-104

C 012  .1 µF ±10% X7R 50V cer 
smd  

510-3606-104

C 013  4.7 µF 10V tantalum smd  510-2624-479

C 014  4.7 µF 10V tantalum smd  510-2624-479

C 015  .01 µF ±5% X7R 50V cer 
smd  

510-3609-103

C 028  .1 µF ±5% X7R 50V cer smd 510-3609-104

C 029 470 pF ±10% 25V cer smd 510-3681-471

     

CR 001 10V zener SOT-23  523-2016-100

CR 002 Switching diode SOT-23  523-1504-002

     

J 201  Connector, 20-pin  515-7111-230

J 202  Connector, 30-pin  515-7106-430

     

L 001 270 nH smd inductor 542-9017-274

L 002 270 nH smd inductor 542-9017-274

L 003 270 nH smd inductor 542-9017-274

   

P 100  Header, 2-pin friction lock  515-9031-201

P 101  Header, 3-pin friction lock  515-9031-202

P 102  Header, 3-pin friction lock  515-9031-202

PC 001 PC board, interface revision 
2 

035-5500-200 2

   

Q 001  NPN general purpose  576-0003-658

Q 002  NPN general purpose  576-0003-658

Q 003  NPN general purpose  576-0003-658

Q 004  NPN general purpose  576-0003-658

     

R 002  2.2 ohm ±5% 1W smd  569-0175-229

R 003  10k ohm ±5% 1/8W smd  569-0105-103

R 004  47k ohm ±5% 1/8W smd  569-0105-473

R 005  10k ohm ±5% 1/8W smd  569-0105-103

R 006  7.5k ohm ±5% 1/8W smd  569-0105-752

R 008  1k ohm ±5% 1/8W smd  569-0115-102

R 009  1k ohm ±5% 1/8W smd  569-0115-102

R 010  1k ohm ±5% 1/8W smd  569-0115-102

R 011  39k ohm ±5% 1/8W smd  569-0155-393

R 012  12k ohm ±5% 1/8W smd  569-0155-123

R 013  10k ohm ±5% 1/8W smd  569-0115-103

R 014  10k ohm ±5% 1/8W smd  569-0115-103

R 015  Zero ohm jumper  569-0115-001

R 016  10k ohm ±5% 1/8W smd  569-0115-103

R 017  3k ohm ±5% 1/8W smd  569-0115-302
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R 018  10k ohm ±5% 1/8W smd  569-0115-103

R 019  Zero ohm jumper  569-0115-001

R 020  10k ohm ±5% 1/8W smd  569-0115-103

R 021  10k ohm ±5% 1/8W smd  569-0115-103

R 022  10k ohm ±5% 1/8W smd  569-0105-103

R 023  12k ohm ±5% 1/8W smd  569-0115-123

R 024  12k ohm ±5% 1/8W smd  569-0155-123

R 025  20k ohm ±5% 1/8W smd  569-0155-203

R 026  13k ohm ±5% 1/8W smd  569-0155-133

R 027  10k ohm ±5% 1/8W smd  569-0115-103

R 028  100k ohm ±5% 1/8W smd  569-0115-104

R 029  100k ohm ±5% 1/8W smd  569-0115-104

R 030  100k ohm ±5% 1/8W smd  569-0115-104

R 031  10k ohm ±5% 1/8W smd  569-0115-103

R 032  10k ohm ±5% 1/8W smd  569-0115-103

R 033  10k ohm ±5% 1/8W smd  569-0115-103

R 034  10k ohm ±5% 1/8W smd  569-0115-103

R 035 10k ohm ±5% 1/8W smd  569-0115-103

R 036 10k ohm ±5% 1/8W smd  569-0115-103

R 037  39k ohm ±5% 1/8W smd  569-0155-393

R 038  470 ohm ±5% 1/8W smd  569-0155-471

R 039  10k ohm ±5% 1/8W smd  569-0155-103

R 040  470 ohm ±5% 1/8W smd  569-0155-471

R 041  10k ohm ±5% 1/8W smd  569-0155-103

     

U 001  Audio amp, 22W TDA1519  544-2004-003

U 002  Voltage regulator, adj 
REG103UA 

544-2603-057

U 003  Op amp, dual LM2904  544-2019-004

U 004  Dig potentiometer, 2-ch 
AD8402 

544-0004-213

U 006 Voltage regulator, adj 
REG103UA 

544-2603-057

U 007 Multiplexer, triple 4053 544-1014-053

U 008 Voltage regulator, adj 
REG103UA 

544-2603-057

U 009 CPLD prog logic device 
XC2C64 

544-5001-420

U 010 Op amp, dual LM2904  544-2019-004

   

 VHF RECEIVER/EXCITER 
ASSEMBLY 

Part No. 023-5517-212 
A 001  Interconnect board assembly 

(see separate listing which 
follows) 

023-5500-050

A 100  RF board assembly, VHF 585-5500-100

   

HW 
001  

Screw, 2-56 x 3/16 pan hd  575-1602-006

HW 
002  

Screw, 4-40 x 1/4 pan hd  575-1604-008

HW 
003  

Lockwasher, internal  596-2102-006

HW 
004  

Washer, split lock #4 ZPS  596-1304-008

     

MP 002 Metal RF board housing  015-0970-014

MP 003 Cover for housing MP2 015-0970-015

MP 004 Grounding clip 537-5001-005

W 001 Coax assy, right angle  597-3008-001

   

   

 INTERCONNECT BOARD ASSEMBLY 
Part No. 023-5500-050 

C 001  39 pF ±5% NPO 50V cer 
smd  

510-3674-390

C 002  39 pF ±5% NPO 50V cer 
smd  

510-3674-390

C 005  39 pF ±5% NPO 50V cer 
smd  

510-3674-390

C 007  39 pF ±5% NPO 50V cer 
smd  

510-3674-390

C 008  39 pF ±5% NPO 50V cer 
smd  

510-3674-390

C 009  39 pF ±5% NPO 50V cer 
smd  

510-3674-390

C 011  39 pF ±5% NPO 50V cer 
smd  

510-3674-390

C 012  39 pF ±5% NPO 50V cer 
smd  

510-3674-390

C 014  39 pF ±5% NPO 50V cer 510-3674-390
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smd  

C 016  39 pF ±5% NPO 50V cer 
smd  

510-3674-390

C 017  .1 µF X7R ±10% 50V cer 
smd  

510-3675-104

C 018  39 pF ±5% NPO 50V cer 
smd  

510-3674-390

C 019  39 pF ±5% NPO 50V cer 
smd  

510-3674-390

C 020  39 pF ±5% NPO 50V cer 
smd  

510-3674-390

C 021  39 pF ±5% NPO 50V cer 
smd  

510-3674-390

C 022  39 pF ±5% NPO 50V cer 
smd  

510-3674-390

C 024  39 pF ±5% NPO 50V cer 
smd  

510-3674-390

C 025  39 pF ±5% NPO 50V cer 
smd  

510-3674-390

C 026  39 pF ±5% NPO 50V cer 
smd  

510-3674-390

C 027  39 pF ±5% NPO 50V cer 
smd  

510-3674-390

C 028  39 pF ±5% NPO 50V cer 
smd  

510-3674-390

C 029  39 pF ±5% NPO 50V cer 
smd  

510-3674-390

     

EP 001  Ferrite bead smd  517-2503-002

EP 002  Ferrite bead smd  517-2503-002

   

J 001 Connector, 26-pin ZIF 
(revised bd) 

515-7111-526

J 002  Connector, 30-pin  515-7111-430

     

PC 001  PC board, interconnect 035-5500-050

   

R 005 0 ohm jumper 569-0165-001

R 007 0 ohm jumper 569-0165-001

R 008 0 ohm jumper 569-0165-001

   

   

VHF 15W PA BOARD 
ASSEMBLY 

Part No. nr3-4315-513 
C 001 .01 µF X7R ±10%  chp  510-3605-103

C 002 .1 µF X7R ±10% chip  510-3606-104

C 003 .018 µF X7R ±10% chp 510-3605-183

C 004 330 pF NPO ±5%  chp  510-3601-331

C 005 .01 µF X7R ±10%  chp  510-3605-103

C 006 330 pF NPO ±5%  chp  510-3601-331

C 007 330 pF NPO ±5%  chp 510-3601-331

C 008 330 pF NPO ±5%  chp 510-3601-331

C 009 330 pF NPO ±5%  chp 510-3601-331

C 010 330 pF NPO ±5%  chp 510-3601-331

C 011 330 pF NPO ±5%  chp 510-3601-331

C 012 330 pF NPO ±5%  chp 510-3601-331

C 013 330 pF NPO ±5%  chp 510-3601-331

C 014 330 pF NPO ±5%  chp 510-3601-331

C 015 Capacitor, 10 pF, 1%, high 
Q, 0805 

510-3661-100

C 016 .01 µF X7R ±10%  chp  510-3605-103

C 017 .01 µF X7R ±10%  chp  510-3605-103

C 018 330 pF NPO ±5%  chp  510-3601-331

C 019 330 pF NPO ±5%  chp  510-3601-331

C 020 330 pF NPO ±5%  chp  510-3601-331

C 021 330 pF NPO ±5%  chp  510-3601-331

C 022 330 pF NPO ±5%  chp  510-3601-331

C 023 470  µF 16V LOW ESR 100 
kHZ 

510-4056-471

C 024 330 pF NPO ±5%  chp 510-3601-331

C 025 .018 µF X7R ±10% chp 510-3605-183

C 026 .018 µF X7R ±10% chp 510-3605-183

C 027 330 pF NPO ±5%  chp  510-3601-331

C 028 330 pF NPO ±5%  chp 510-3601-331

C 029 .0047 µF X7R ±10%  chip 510-3606-472

C 030 6.8 µF 35V SMD TANT 510-2635-689

C 031 330 pF NPO ±5%  chp 510-3601-331

C 032 330 pF NPO ±5%  chp 510-3601-331

C 033 .018 µF X7R ±10% chp 510-3605-183



70 

C 034 6.8 µF 35V SMD tant 510-2635-689

C 035 .001 µF ±5% chip 510-3602-102

C 036 330 pF NPO ±5%  chp  510-3601-331

C 037 .018 µF X7R ±10% chp 510-3605-183

C 038 6.8 µF 35V SMD tant 510-2635-689

C 039 330 pF NPO ±5%  chp 510-3601-331

C 040 100 pF NPO ±5%   chp  510-3601-101

C 041 330 pF NPO ±5%  chp  510-3601-331

C 042 330 pF NPO ±5%  chp 510-3601-331

C 044 Capacitor, 6.8 pF, 1%, high 
Q 

510-3661-689

C 045 Capacitor, 150 pF, 1%, high 
Q 

510-3661-151

C 046 Capacitor, 43 pF, 1%, high Q 510-3661-430

C 048 Capacitor, 10 pF, 1%, high Q 510-3661-100

C 049 Capacitor, 39 pF, 1%, high 
Q,  

510-3661-390

C 050 Capacitor, 240 pF, 1%, high 
Q 

510-3661-241

C 051 Capacitor, 240 pF, 1%, high 
Q 

510-3661-241

C 054 330 pF NPO ±5% chp  510-3601-331

C 055 Capacitor, 22 pF, 1%, high Q 
SMD 

510-3666-220

C 056 Capacitor, 15 pF, 1%, high Q 
SMD 

510-3666-150

C 057 Capacitor, 22 pF, 1%,  high 
Q SMD 

510-3666-220

C 058 Capacitor, 240 pF, 1%, high 
Q 

510-3661-241

C 059 330 pF NPO ±5% chp 510-3601-331

C 060 Capacitor, 10 pF, 1%, high Q 
SMD 

510-3666-100

C 061 Capacitor, 10 pF, 1%, high Q 
SMD 

510-3666-100

C 062 Capacitor, 330 pF, 1%, high 
Q SMD 

510-3666-331

C 063 Capacitor, 12 pF, 1%, high Q 
SMD 

510-3666-120

C 064 Capacitor, 22 pF, 1%, high 
Q,  

510-3661-220

C 065 330 pF NPO ±5% chp  510-3601-331

C 066 Capacitor, 18 pF, 1%, high 510-3661-180

Q,  

C 067 330 pF NPO ±5% chp 510-3601-331

C 069 330 pF NPO ±5% chp 510-3601-331

C 070 100 pF NPO ±5% chp 510-3601-101

C 071 330 pF NPO ±5%  chp 510-3601-331

C 072 .018 µF X7R ±10% chp 510-3605-183

C 073 330 pF NPO ±5% chp 510-3601-331

C 074 330 pF NPO ±5%  chp 510-3601-331

C 075 Capacitor, 33 pF, 1%, high Q 510-3661-330

C 076 Capacitor, 18 pF, 1%, high Q 510-3661-180

C 077 Capacitor, 18 pF, 1%, high Q 510-3661-180

C 078 Capacitor, 180 pF, 1%, high 
Q 

510-3661-181

C 079 1500  µF 25V low ESR 100 
kHZ 

510-4055-152

C 082 1 µf 16V chip cap 510-3606-105

C 083 10 µF 25V SMD TANT  510-2627-100

C 084 1 µf 16V chip cap 510-3606-105

C 085 .1 µF X7R ±10% chip 510-3606-104

C 086 470 µF 16V low ESR 100 
kHZ 

510-4056-471

C 087 .018 µF X7R ±10% chp 510-3605-183

C 088 330 pF NPO ±5% chp 510-3601-331

C 089 1 µf 16V chip cap 510-3606-105

C 090 470  µF 16V low ESR 100 
kHZ 

510-4056-471

C 091 1 µf 16V chip cap 510-3606-105

C 092 330 pF NPO ±5% chp 510-3601-331

C 093 330 pF NPO ±5% chp 510-3601-331

C 095 1 µf 16V chip cap 510-3606-105

C 096 Capacitor, 10 pF, 1%, HIGH 
Q, 0805 

510-3661-100

C 097 Capacitor, 10 pF, 1%, HIGH 
Q, 0805 

510-3661-100

C 098 Capacitor, 4.7 pF, 1%, HIGH 
Q, 0805 

510-3661-479

C 099 Capacitor, 15 pF, 1%, HIGH 
Q, 0805 

510-3661-150

C 100 Capacitor, 13 pF, 1%, HIGH 
Q SURFACE MOUNT 

510-3666-130

C 230 .1 µF X7R ±10% chip 510-3606-104
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C 560 1 µf 16V chip cap 510-3606-105

   

CR 001 Switching diode SOT-23 523-1504-002

CR 002 Switching diode SOT-23 523-1504-002

CR 003 Switching diode SOT-23 523-1504-002

CR 004 Diode, HIPAX PIN 523-1504-036

CR 005 Diode, HIPAX PIN 523-1504-036

CR 006 Diode, HIPAX PIN 523-1504-036

CR 007 Diode, HIPAX PIN 523-1504-036

CR 008 HC diode SOT-23 523-1504-016

CR 009 Diode, HIPAX PIN 523-1504-036

CR 010 Diode, 1 amp SMD fast 
recovery 

523-1600-001

CR 011 Diode, SOT PIN SW  523-1504-001

CR 012 Diode, HIPAX PIN 523-1504-036

CR 014 Zener overvoltage transient 
suppressor 

523-2907-016

CR 015 Diode, SOT PIN SW  523-1504-001

   

D 001 Diode, 5 amp SMD fast 
recovery 

523-1601-550

   

J 001 Conn 2O POS bot entry 
SFMT 

515-7111-230

J 002 SMT Receptacle MMS  515-7111-470

J 003 SMT Receptacle MMS  515-7111-470

   

L 001 330  nH 0805 SMD 10% 
inductor 

542-9003-338

L 002 10  nH 0805 SMD 10% 
inductor 

542-9003-107

L 003 330  nH 0805 SMD 10% 
inductor 

542-9003-338

L 004 10  nH 0805 SMD 10% 
inductor 

542-9003-107

L 005 Ferrite bead SMD  517-2503-010

L 006 Ferrite bead SMD  517-2503-010

L 007 8T .120-in id air die SMD 
inductor 

542-0020-058

L 008 33  nH  SMD 10% inductor 542-9003-337

L 009 330  nH SMD 10% inductor 542-9003-338

L 010 330  nH 0805 SMD 10% 
inductor 

542-9003-338

L 011 2T .230” ID air die SMD 
inductor 

016-0020-082

L 012 2T .230” ID air die SMD 
inductor 

016-0020-082

L 013 2T .230” ID air die SMD 
inductor 

016-0020-082

L 016 9700 DC line filter, field-
installed 

542-5010-003

L 018 330 nH 0805 SMD 10% 
inductor 

542-9003-338

L 019 220 nH  0805 SMD 10% 
inductor 

542-9003-228

L 020 39  nH 0805 SMD 10% 
inductor 

542-9003-397

L 021 3T .080-in ID air die SMD 
inductor 18 AWG 

542-0020-033

L 022 3T .080-in ID air die SMD 
inductor 18 AWG 

542-0020-033

L 080 330  nH 0805 SMD 10% 
inductor 

542-9003-338

   

Q 001 XSTR, switching PNP 576-0003-612

Q 002 XSTR,3904,SI,NPN SOT-
23(T&R) 

576-0003-658

Q 003 XSTRSI, NPN SOT-23 576-0003-658

Q 004 XSTR, switching PNP 576-0003-612

Q 005 XSTR, SI, NPN SOT-23 576-0003-658

Q 006 LDMOS 35-W VHF/UHF 
12.5-V FET 

576-0006-453

Q 007 XSTR, SI, NPN SOT-23 576-0003-658

Q 008 PNP power Darlington 
XSTR TO-220 

576-0007-013

Q 009 XSTR, SI, NPN SOT-23 576-0003-658

Q 010 XSTR, switching PNP 576-0003-612

   

R 001 20k ohm ±5% chip 569-0105-203

R 002 20k ohm ±5% chip 569-0105-203

R 003 10k ohm ±5% chip 569-0105-103

R 004 20k ohm ±5% chip 569-0105-203

R 005 10k ohm ±5% chip 569-0105-103

R 006 20k ohm ±5% chip 569-0105-203
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R 007 10k ohm ±5% chip 569-0105-103

R 008 4.3k ohm ±5% chip 569-0105-432

R 009 20k ohm ±5% chip 569-0105-203

R 010 10k ohm ±5% chip 569-0105-103

R 011 100K ohm 1%  SMD resistor 569-0101-501

R 012 20k ohm ±5% chip 569-0105-203

R 013 10k ohm ±5% chip 569-0105-103

R 015 10k ohm ±5% chip 569-0105-103

R 016 20k ohm ±5% chip 569-0105-203

R 017 10k ohm ±5% chip 569-0105-103

R 018 20k ohm ±5% chip 569-0105-203

R 019 Zero ohm ±5% SMD 569-0115-001

R 020 100k ohm ±5% chip 569-0105-104

R 021 47k ohm ±5%  chip 569-0105-473

R 022 2.2k ohm ±5% chip 569-0105-222

R 024 1.8k ohm ±5% chip 569-0105-182

R 025 120 ohm ±5%  chip 569-0105-121

R 026 1.0k ohm ±5%  chip 569-0105-102

R 027 7.5k ohm ±5% chip 569-0105-752

R 028 10k ohm ±5% chip 569-0105-103

R 029 10k ohm ±5% chip 569-0105-103

R 031 1.8k ohm ±5% chip 569-0105-182

R 032 51 ohm ±5%  SMD 569-0175-510

R 033 .015 ohm 2W 5% 569-2019-157

R 034 47k ohm ±5% chip 569-0105-473

R 035 510 ohm ±5% chip 569-0105-511

R 036 47k ohm ±5% chip 569-0105-473

R 037 4.3k ohm ±5% chip 569-0105-432

R 038 51 ohm ±5%  smd 569-0175-510

R 039 620 ohm ±5% chip 569-0105-621

R 040 47k ohm ±5% chip 569-0105-473

R 042 47k ohm ±5% chip 569-0105-473

R 043 220 ohm ±5% chip 569-0105-221

R 044 1.2k ohm ±5% chip 569-0105-122

R 045 100 ohm ±5% chip 569-0105-101

R 046 100 ohm ±5% chip 569-0105-101

R 047 100 ohm ±5% chip 569-0105-101

R 048 100 ohm ±5% chip 569-0105-101

R 049 100 ohm ±5% chip 569-0105-101

R 050 100 ohm ±5% chip 569-0105-101

R 051 1.0k ohm ±5% chip 569-0105-102

R 052 200 ohm ±5% chip 569-0105-201

R 053 220k ohm ±5% chip 569-0105-224

R 054 220k ohm ±5% chip 569-0105-224

R 055 100k ohm ±5% chip 569-0105-104

R 056 100 ohm ±5% chip 569-0105-101

R 057 100 ohm ±5% 0.75-W SMD 569-0135-101

R 058 220k ohm ±5% chip 569-0105-224

R 059 510 ohm ±5% chip 569-0105-511

R 060 510 ohm ±5% chip 569-0105-511

R 061 220k ohm ±5% chip 569-0105-224

R 062 51 ohm ±5% 1-W SMD 569-0175-510

R 063 68k ohm ±5% chip 569-0105-683

R 064 47k ohm ±5% chip 569-0105-473

R 065 47k ohm ±5% chip 569-0105-473

R 066 100k ohm ±5% chip 569-0105-104

R 067 560 ohm ±5% chip 569-0105-561

R 068 47k ohm ±5% chip 569-0105-473

R 069 100 ohm ±5% chip 569-0105-101

R 070 1.2k ohm ±5% smd 569-0115-122

R 071 1.2k ohm ±5% smd 569-0115-122

R 072 1.2k ohm ±5% smd 569-0115-122

R 073 560 ohm ±5% chip 569-0105-561

R 074 510 ohm ±5% chip 569-0105-511

R 270 220k ohm ±5% chip 569-0105-224

R 370 5.1k ohm ±5% chip 569-0105-512

   

TR 001 Chip therm 10k ohm ±5%  569-3013-007

   

U 001 Shift reg. 8-STG SOIC 544-3016-094

U 002 Dual op amp SO-8 544-2019-004

U 003 AMP, HI-side current sense, 
SO-8 

544-2039-002

U 004 Regulator, adjustable, 5 amp 544-2500-001
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 LOGIC BOARD ASSEMBLY 
Part No. 023-5500-600 

   

A 001 SEM encryption module  023-5000-980

   

C 001 .01 µF ±10% X7R 25V cer 
smd 

510-3675-103

C 013 .1 µF ±10% X7R 25V cer 
smd 

510-3675-104

C 014 .1 µF ±10% X7R 25V cer 
smd 

510-3675-104

C 052 33pF ±10% 10V cer smd 510-3681-330

C 053 33pF ±10% 10V cer smd 510-3681-330

C 054 33pF ±10% 10V cer smd 510-3681-330

C 055 33pF ±10% 10V cer smd 510-3681-330

C 056 33pF ±10% 10V cer smd 510-3681-330

C 057 33pF ±10% 10V cer smd 510-3681-330

C 058 0.01 µF ±10% 10V cer smd 510-3681-103

C 064 0.1 µF +80-20% Z5U 25V 
cer smd 

510-3680-104

C 065 0.01 ±10% 10V cer smd 510-3681-103

C 066 2.2 µF 16V ceramic smd 510-3925-225

C 069  0.1 µF+80-20% Z5U 25V 
cer smd 

510-3680-104

C 070 0.01 µF ±10% 10V cer smd 510-3681-103

C 071 2.2 µF 16V ceramic smd 510-3925-225

C 078 2.2 µF 16V ceramic smd 510-3925-225

C 079 1 µF +80-20% Z5U 25V cer 
smd 

510-3631-105

C 080 .01 µF ±10% 10V cer smd 510-3681-103

C 081 1.5F electrolytic 510-9510-057

C 125 .1 µF ±10% X7R 25V cer 
smd 

510-3675-104

C 126 .01 µF ±10% 10V cer smd 510-3681-103

C 127 .01 µF ±10% 10V cer smd 510-3681-103

C 128 .01 µF ±10% 10V cer smd 510-3681-103

C 129 .01 µF ±10% 10V cer smd 510-3681-103

C 130 .01 µF ±10% 10V cer smd 510-3681-103

C 131 .01 µF ±10% 10V cer smd 510-3681-103

C 183 .01 µF ±10% 10V cer smd 510-3681-103

C 184 .01 µF ±10% 10V cer smd 510-3681-103

C 185 .01 µF ±10% 10V cer smd 510-3681-103

C 186 .01 µF ±10% 10V cer smd 510-3681-103

C 190 .01 µF ±10% 10V cer smd 510-3681-103

C 191 .01 µF ±10% 10V cer smd 510-3681-103

C 192 .01 µF ±10% 10V cer smd 510-3681-103

C 196 .1 µF ±10% X7R 25V cer 
smd 

510-3675-104

C 197 .1 µF ±10% X7R 25V cer 
smd 

510-3675-104

C 198 .1 µF ±10% X7R 25V cer 
smd 

510-3675-104

C 199 .1 µF ±10% X7R 25V cer 
smd 

510-3675-104

C 200 .01 µF ±10% X7R 25V cer 
smd 

510-3675-104

C 201 .1 µF ±10% X7R 25V cer 
smd 

510-3675-104

C 202 .1 µF ±10% X7R 25V cer 
smd 

510-3675-104

C 203 .1 µF ±10% X7R 25V cer 
smd 

510-3675-104

C 204 .1 µF ±10% X7R 25V cer 
smd 

510-3675-104

C 205 .1 µF ±10% X7R 25V cer 
smd 

510-3675-104

C 206 .1 µF ±10% X7R 25V cer 
smd 

510-3675-104

C 207 .1 µF ±10% X7R 25V cer 
smd 

510-3675-104

C 208 .1 µF ±10% X7R 25V cer 
smd 

510-3675-104

C 209 .1 µF ±10% X7R 25V cer 
smd 

510-3675-104

C 210 .1 µF ±10% X7R 25V cer 
smd 

510-3675-104

C 211 .1 µF ±10% X7R 25V cer 
smd 

510-3675-104

C 212 .01 µF ±10% 10V cer smd 510-3681-103

C 213 .01 µF ±10% 10V cer smd 510-3681-103

C 214 .01 µF ±10% 10V cer smd 510-3681-103

C 215 .01 µF ±10% 10V cer smd 510-3681-103

C 216 .01 µF ±10% 10V cer smd 510-3681-103
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C 217 .01 µF ±10% 10V cer smd 510-3681-103

C 218 .01 µF ±10% 10V cer smd 510-3681-103

C 219 .01 µF ±10% 10V cer smd 510-3681-103

C 220 .01 µF ±10% 10V cer smd 510-3681-103

C 221 .01 µF ±10% 10V cer smd 510-3681-103

C 222 .01 µF ±10% 10V cer smd 510-3681-103

C 223 .01 µF ±10% 10V cer smd 510-3681-103

C 224 .01 µF ±10% 10V cer smd 510-3681-103

C 225 .01 µF ±10% 10V cer smd 510-3681-103

C 226 10 µF 10V cer smd  510-3755-106

C 227 .1 µF ±10% X7R 25V cer 
smd 

510-3675-104

C 228 3300 pF ±10% 10V cer smd 510-3681-332

C 229 56 pF ±5% 50V cer smd 510-3684-560

C 230 47 pF ±10% cer smd 510-3681-470

C 231 1 µF ±20% Z5U 25V cer 
smd 

510-3636-105

C 232 1 µF ±20% Z5U 25V cer 
smd 

510-3636-105

C 233 220 pF ±5% NPO 25V cer 
smd 

510-3674-221

C 234 470 pF ±5% NPO 25V cer 
smd 

510-3674-471

C 235 .1 µF +80-20% Z5U 25V cer 
smd 

510-3680-104

C 236 .1 µF +80-20% Z5U 25V cer 
smd 

510-3680-104

C 237 .1 µF +80-20% Z5U 25V cer 
smd 

510-3680-104

C 238 .1 µF +80-20% Z5U 25V cer 
smd 

510-3680-104

C 239 1 µF ±20% Z5U 25V cer 
smd 

510-3636-105

C 240 1 µF ±20% Z5U 25V cer 
smd 

510-3636-105

C 241 220 pF ±5% NPO 25V cer 
smd 

510-3674-221

C 242 .1 µF +80-20% Z5U 25V cer 
smd 

510-3680-104

C 243 100 pF ±5% NPO 25V cer 
smd 

510-3674-101

C 245 1 µF ±20% Z5U 25V cer 
smd 

510-3636-105

C 246 1 µF ±20% Z5U 25V cer 
smd 

510-3636-105

C 247 .1 µF +80-20% Z5U 25V cer 
smd 

510-3680-104

C 248 4700 pF 10% X7R 25V cer 
smd 

510-3675-472

C 249 470 pF ±5% NPO 25V cer 
smd 

510-3674-471

C 250 .1 µF +80-20% Z5U 25V cer 
smd 

510-3680-104

C 251 220 pF ±5% NPO 25V cer 
smd 

510-3674-221

C 252 220 pF ±5% NPO 25V cer 
smd 

510-3674-221

C 253 .1 µF +80-20% Z5U 25V cer 
smd 

510-3680-104

C 254 .1 µF +80-20% Z5U 25V cer 
smd 

510-3680-104

C 255 10 µF 10V tantalum smd 510-2624-100

C 257 .1 µF +80-20% Z5U 25V cer 
smd 

510-3680-104

C 258 10 µF 10V tantalum smd 510-2624-100

C 261 .1 µF +80-20% Z5U 25V cer 
smd 

510-3680-104

C 262 .1 µF +80-20% Z5U 25V cer 
smd 

510-3680-104

C 263 .1 µF +80-20% Z5U 25V cer 
smd 

510-3680-104

C 263 .1 µF +80-20% Z5U 25V cer 
smd 

510-3680-104

C 264 .1 µF +80-20% Z5U 25V cer 
smd 

510-3680-104

C 265 .1 µF +80-20% Z5U 25V cer 
smd 

510-3680-104

C 266 470 pF ±5% NPO 25V cer 
smd 

510-3674-471

C 267 470 pF ±5% NPO 25V cer 
smd 

510-3674-471

C 268 470 pF ±5% NPO 25V cer 
smd 

510-3674-471

C 269 470 pF ±5% NPO 25V cer 
smd 

510-3674-471

C 270 470 pF ±5% NPO 25V cer 
smd 

510-3674-471

C 271 470 pF ±5% NPO 25V cer 510-3674-471
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smd 

C 272 470 pF ±5% NPO 25V cer 
smd 

510-3674-471

C 273 470 pF ±5% NPO 25V cer 
smd 

510-3674-471

C 274 470 pF ±5% NPO 25V cer 
smd 

510-3674-471

C 275 470 pF ±5% NPO 25V cer 
smd 

510-3674-471

C 276 470 pF ±5% NPO 25V cer 
smd 

510-3674-471

C 277 470 pF ±5% NPO 25V cer 
smd 

510-3674-471

C 278 470 pF ±5% NPO 25V cer 
smd 

510-3674-471

C 279 470 pF ±5% NPO 25V cer 
smd 

510-3674-471

C 281 470 pF ±5% NPO 25V cer 
smd 

510-3674-471

C 282 470 pF ±5% NPO 25V cer 
smd 

510-3674-471

C 283 470 pF ±5% NPO 25V cer 
smd 

510-3674-471

C 284 470 pF ±5% NPO 25V cer 
smd 

510-3674-471

C 285 470 pF ±5% NPO 25V cer 
smd 

510-3674-471

C 286 470 pF ±5% NPO 25V cer 
smd 

510-3674-471

C 287 470 pF ±5% NPO 25V cer 
smd 

510-3674-471

C 288 470 pF ±5% NPO 25V cer 
smd 

510-3674-471

C 289 470 pF ±5% NPO 25V cer 
smd 

510-3674-471

C 290 470 pF ±5% NPO 25V cer 
smd 

510-3674-471

C 291 470 pF ±5% NPO 25V cer 
smd 

510-3674-471

C 292 470 pF ±5% NPO 25V cer 
smd 

510-3674-471

C 293 470 pF ±5% NPO 25V cer 
smd 

510-3674-471

C 294 470 pF ±5% NPO 25V cer 
smd 

510-3674-471

C 295 470 pF ±5% NPO 25V cer 
smd 

510-3674-471

C 296 470 pF ±5% NPO 25V cer 
smd 

510-3674-471

C 299 470 pF ±5% NPO 25V cer 
smd 

510-3674-471

C 302 470 pF ±5% NPO 25V cer 
smd 

510-3674-471

C 303 470 pF ±5% NPO 25V cer 
smd 

510-3674-471

C 304 470 pF ±5% NPO 25V cer 
smd 

510-3674-471

C 305 470 pF ±5% NPO 25V cer 
smd 

510-3674-471

C 306 470 pF ±5% NPO 25V cer 
smd 

510-3674-471

C 308 0.01 µF ±10% X7R 25V cer 
smd  

510-3675-103

C 309 470 pF ±5% NPO 25V cer 
smd 

510-3674-471

C 312 .1 µF ±10% X7R 25V cer 
smd 

510-3675-104

C 313 .1 µF ±10% X7R 25V cer 
smd 

510-3675-104

C 314 .1 µF ±10% X7R 25V cer 
smd 

510-3675-104

C 315 .1 µF ±10% X7R 25V cer 
smd 

510-3675-104

C 316 10 µF 10V cer smd  510-3755-106

C 317 8.2pF +/-.1pF NPO cer smd 510-3673-829

C 318 22 µF ±10% 16V X5R smd 510-3607-226

C 319 .1 µF ±10% X7R 25V cer 
smd 

510-3675-104

C 320 10 µF 10V cer smd  510-3755-106

C 321 10 pF ±.1 pF NPO cer smd 510-3673-100

C 322 10 pF ±.1 pF NPO cer smd 510-3673-100

C 323 22 µF ±10% 16V X5R smd 510-3607-226

C 324 .1 µF ±10% X7R 25V cer 
smd 

510-3675-104

C 325 4.7 µF 20V tantalum smd 510-2626-479

C 326 0.01 µF ±10% X7R 25V cer 
smd  

510-3675-103

C 327 0.01 µF ±10% X7R 25V cer 
smd  

510-3675-103
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C 328 .01 µF ±10% 10V cer smd 510-3681-103

C 329 .01 µF ±10% 10V cer smd 510-3681-103

C330 .01 µF ±10% 10V cer smd 510-3681-103

C331 .01 µF ±10% 10V cer smd 510-3681-103

C332 .1 µF ±10% X7R 25V cer 
smd 

510-3675-104

C333 .1 µF ±10% X7R 25V cer 
smd 

510-3675-104

C334 .1 µF ±10% X7R 25V cer 
smd 

510-3675-104

C335 .01 µF ±10% 10V cer smd 510-3681-103

C336 .01 µF ±10% 10V cer smd 510-3681-103

C337 .01 µF ±10% 10V cer smd 510-3681-103

C338 .1 µF ±10% X7R 25V cer 
smd 

510-3675-104

C339 .1 µF ±10% X7R 25V cer 
smd 

510-3675-104

C 340 .1 µF ±10% X7R 25V cer 
smd 

510-3675-104

C 341  100 pF ±10% 25V cer smd 510-3681-101

C 342  100 pF ±10% 25V cer smd 510-3681-101

C 343 .01 µF ±10% 10V cer smd 510-3681-103

C 344 .01 µF ±10% 10V cer smd 510-3681-103

C 345 .01 µF ±10% 10V cer smd 510-3681-103

C 346 .01 µF ±10% 10V cer smd 510-3681-103

C 347 .01 µF ±10% 10V cer smd 510-3681-103

C 348 .01 µF ±10% 10V cer smd 510-3681-103

C 349 0.01 µF ±10% X7R 25V cer 
smd  

510-3675-103

C 350 .01 µF ±10% 10V cer smd 510-3681-103

C 351 2.2 µF 16V cer smd 510-3925-225

C 352 .1 µF ±10% X7R 25V cer 
smd 

510-3675-104

C 353 .1 µF ±10% X7R 25V cer 
smd 

510-3675-104

C 354 .1 µF ±10% X7R 25V cer 
smd 

510-3675-104

C 355 .1 µF ±10% X7R 25V cer 
smd 

510-3675-104

   

CR 001 Silicon switching diode 523-1004-021

CR 002 Silicon switching diode  523-1004-021

CR 003 Silicon switching diode  523-1004-021

CR 004 Zener diode, 5.6V  523-2016-569

CR 005 Zener diode, 18V  523-2601-180

CR 006 Zener diode, 5.1V 523-2601-519

CR 010 Zener diode, 3.6V  523-2016-369

CR 011 Zener diode, 3.6V  523-2016-369

CR 012 Silicon switching diode 523-1004-021

CR 013 LED, green 549-4003-011

CR 014 LED, green 549-4003-011

CR 015 LED, green 549-4003-011

   

D 002 Dual switching diode, com 
cath 

523-1504-022

D 003 Dual switching diode, com 
cath 

523-1504-022

D 004 Dual switching diode, com 
cath 

523-1504-022

D 005 Dual switching diode, com 
cath 

523-1504-022

D 006 Dual switching diode, com 
cath 

523-1504-022

   

F 001 Fuse, 0.5A smd 534-5002-009

   

J 001 Connector, 16-pin 515-7000-668

J 002 Connector, 25-pin 515-7113-071

J 005 Connector, 13-pin 515-7111-262

J 006 Connector, 13-pin 515-7111-262

J 007 Connector, 5-pin 515-7111-254

J 008 Connector, 12-pin 515-7111-261

J 009 Connector, 2 14-pin 515-9500-045

J 011 Connector, 5-pin 515-7111-254

J 012 Connector, 13-pin 515-7111-262

J 016 Connector, 25-pin 515-7113-071

J 018 Connector, 25-pin 515-7113-071

   

L 015 - Inductor, ferrite smd 542-9230-023

 L 053   

L 054 8.2 µH ±5% smd 542-9000-829
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L 055 Bead, ferrite smd 542-9230-005

L 056 Bead, ferrite smd 542-9230-005

L 057 Inductor, ferrite smd 542-9230-021

L 058 Inductor, ferrite smd 542-9230-021

L 059 Inductor, ferrite smd 542-9230-021

L 060 Inductor, ferrite smd 542-9230-021

L 061 Inductor, ferrite smd 542-9230-021

L 062 Inductor, ferrite smd 542-9230-021

L 063 Bead, ferrite smd 542-9230-005

L 064 10 µH power inductor 542-9009-100

L 065 10 µH power inductor 542-9009-100

   

PC 001 PC board, 5500 logic rev 1 035-5500-600 
1 

   

Q 005 N-chan MOSFET 60V 1A 576-0003-725

Q 006 NPN general purpose 576-0003-658

Q 009 NPN general purpose 576-0003-658

Q 010 NPN general purpose 576-0003-658

Q 011 NPN general purpose 576-0003-658

Q 012 NPN general purpose 576-0003-658

Q 013 NPN general purpose 576-0003-658

Q 014 NPN general purpose 576-0003-658

Q 015 NPN general purpose 576-0003-658

Q 017 NPN general purpose 576-0003-658

Q 018 NPN general purpose 576-0003-658

Q 020 NPN general purpose 576-0003-658

Q 021 NPN general purpose 576-0003-658

Q 022 NPN general purpose 576-0003-658

Q 023 NPN general purpose 576-0003-658

Q 024 NPN general purpose 576-0003-658

Q 025 NPN general purpose 576-0003-658

Q 026 NPN general purpose 576-0003-658

Q 027 NPN general purpose 576-0003-658

Q 028 NPN general purpose 576-0003-658

Q 029 NPN general purpose 576-0003-658

   

R 001 10k ohm ±5% 1/16W smd 569-0165-103

R 002 51k ohm ±5% 1/16W smd 569-0165-513

R 003 51k ohm ±5% 1/16W smd 569-0165-513

R 004 51k ohm ±5% 1/16W smd 569-0165-513

R 006 4.7k ohm ±5% 1/16W smd 569-0165-472

R 007 4.7k ohm ±5% 1/16W smd 569-0165-472

R 008 4.7k ohm ±5% 1/16W smd 569-0165-472

R 009 4.7k ohm ±5% 1/16W smd 569-0165-472

R 010 4.7k ohm ±5% 1/16W smd 569-0165-472

R 011 4.7k ohm ±5% 1/16W smd 569-0165-472

R 012 4.7k ohm ±5% 1/16W smd 569-0165-472

R 013 4.7k ohm ±5% 1/16W smd 569-0165-472

R 014 4.7k ohm ±5% 1/16W smd 569-0165-472

R 015 4.7k ohm ±5% 1/16W smd 569-0165-472

R 016 4.7k ohm ±5% 1/16W smd 569-0165-472

R 017 4.7k ohm ±5% 1/16W smd 569-0165-472

R 018 100k ohm ±5% 1/16W smd 569-0165-104

R 019 4.7k ohm ±5% 1/16W smd 569-0165-472

R 020 4.7k ohm ±5% 1/16W smd 569-0165-472

R 021 4.7k ohm ±5% 1/16W smd 569-0165-472

R 022 4.7k ohm ±5% 1/16W smd 569-0165-472

R 023 4.7k ohm ±5% 1/16W smd 569-0165-472

R 024 4.7k ohm ±5% 1/16W smd 569-0165-472

R 025 4.7k ohm ±5% 1/16W smd 569-0165-472

R 029 51k ohm ±5% 1/16W smd 569-0165-513

R 030 51k ohm ±5% 1/16W smd 569-0165-513

R 031 51k ohm ±5% 1/16W smd 569-0165-513

R 038 47k ohm ±5% 1/16W smd 569-0155-473

R 039 47k ohm ±5% 1/16W smd 569-0155-473

R 040 620 ohm ±5% smd 569-0105-621

R 041 620 ohm ±5% smd 569-0105-621

R 076 100 ohm ±5% 1/16W smd  569-0165-101

R 078 10 ohm ±5% 1/16W smd 569-0165-100

R 080 1k ohm ±5% 1/16W smd 569-0155-102

R 095 220k ohm ±5% 1/16W smd 569-0155-224

R 098 10k ohm ±5% 1/16W smd 569-0155-103

R 099 10k ohm ±5% 1/16W smd 569-0155-103

R 100 10k ohm ±5% 1/16W smd 569-0155-103

R 101 4.7k ohm ±5% 1/16W smd 569-0165-472
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R 102 4.7k ohm ±5% 1/16W smd 569-0165-472

R 103 100k ohm ±5% 1/16W smd 569-0165-104

R 104 100k ohm ±5% 1/16W smd 569-0165-104

R 105 220k ohm ±5% 1/16W smd 569-0165-224

R 106 220k ohm ±5% 1/16W smd 569-0165-224

R 107 1k ohm ±5% 1/16W smd 569-0165-102

R 108 220k ohm ±5% 1/16W smd 569-0165-224

R 109 2k ohm ±5% 1/16W smd 569-0165-202

R 110 4.7k ohm ±5% 1/16W smd 569-0165-472

R 111 2k ohm ±5% 1/16W smd 569-0165-202

R 112 2k ohm ±5% 1/16W smd 569-0165-202

R 113 220k ohm ±5% 1/16W smd 569-0165-224

R 114 4.7k ohm ±5% 1/16W smd 569-0165-472

R 115 220k ohm ±5% 1/16W smd 569-0165-224

R 117 220k ohm ±5% 1/16W smd 569-0165-224

R 118 220k ohm ±5% 1/16W smd 569-0165-224

R 119 220k ohm ±5% 1/16W smd 569-0165-224

R 120 220k ohm ±5% 1/16W smd 569-0165-224

R 121 220k ohm ±5% 1/16W smd 569-0165-224

R 122 220k ohm ±5% 1/16W smd 569-0165-224

R 123 220k ohm ±5% 1/16W smd 569-0165-224

R 124 220k ohm ±5% 1/16W smd 569-0165-224

R 125 220k ohm ±5% 1/16W smd 569-0165-224

R 126 220k ohm ±5% 1/16W smd 569-0165-224

R 127 220k ohm ±5% 1/16W smd 569-0165-224

R 128 220k ohm ±5% 1/16W smd 569-0165-224

R 129 220k ohm ±5% 1/16W smd 569-0165-224

R 130 220k ohm ±5% 1/16W smd 569-0165-224

R 131 220k ohm ±5% 1/16W smd 569-0165-224

R 132 4.7k ohm ±5% 1/16W smd 569-0165-472

R 141 47k ohm ±5% 1/16W smd 569-0155-473

R 224 10k ohm ±5% 1/16W smd 569-0165-103

R 225 10k ohm ±5% 1/16W smd 569-0165-103

R 226 10k ohm ±5% 1/16W smd 569-0165-103

R 249 10k ohm ±5% 1/16W smd 569-0155-103

R 251 10k ohm ±5% 1/16W smd 569-0155-103

R 252 10 ohm ±5% 1/16W smd 569-0165-100

R 253 10 ohm ±5% 1/16W smd 569-0165-100

R 255 10 ohm ±5% 1/16W smd 569-0165-100

R 256 10 ohm ±5% 1/16W smd 569-0165-100

R 257 1k ohm ±5% 1/16W smd 569-0165-102

R 258 2k ohm ±5% 1/16W smd 569-0155-202

R 259 10M ohm ±5% 1/16W smd 569-0165-106

R 260 2k ohm ±5% 1/16W smd 569-0155-202

R 261 220k ohm ±5% 1/16W smd 569-0165-224

R 262 330 ohm ±5% 1/16W smd 569-0155-331

R 263 100k ohm ±5% 1/16W smd 569-0165-104

R 264 100k ohm ±5% 1/16W smd 569-0165-104

R 265 100k ohm ±5% 1/16W smd 569-0165-104

R 266 6.8k ohm ±5% 1/16W smd 569-0155-682

R 267 330 ohm ±5% 1/16W smd 569-0155-331

R 268 100k ohm ±5% 1/16W smd 569-0165-104

R 269 220k ohm ±5% 1/16W smd 569-0165-224

R 270 62k ohm ±5% 1/16W smd 569-0155-623

R 271 150k ohm ±5% 1/16W smd 569-0155-154

R 272 6.8k ohm ±5% 1/16W smd 569-0155-682

R 273 6.8k ohm ±5% 1/16W smd 569-0155-682

R 274 220k ohm ±5% 1/16W smd 569-0165-224

R 275 330 ohm ±5% 1/16W smd 569-0155-331

R 276 6.8k ohm ±5% 1/16W smd 569-0155-682

R 277 100k ohm ±5% 1/16W smd 569-0165-104

R 278 100k ohm ±5% 1/16W smd 569-0165-104

R 279 100k ohm ±5% 1/16W smd 569-0165-104

R 280 330 ohm ±5% 1/16W smd 569-0155-331

R 281 220k ohm ±5% 1/16W smd 569-0165-224

R 282 0 ohm jumper 569-0155-001

R 283 100k ohm ±5% 1/16W smd 569-0165-104

R 284 100k ohm ±5% 1/16W smd 569-0155-104

R 285 10k ohm ±5% 1/16W smd 569-0155-103

R 286 100k ohm ±5% 1/16W smd 569-0165-104

R 287 20k ohm ±5% 1/16W smd 569-0155-203

R 288 56k ohm ±5% 1/16W smd 569-0155-563

R 289 390k ohm ±5% 1/16W smd 569-0155-394

R 290 6.8k ohm ±5% 1/16W smd 569-0155-682

R 291 47k ohm ±5% 1/16W smd 569-0155-473

R 292 47k ohm ±5% 1/16W smd 569-0155-473
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R 293 6.8k ohm ±5% 1/16W smd 569-0155-682

R 294 100k ohm ±5% 1/16W smd 569-0155-104

R 295 150 ohm ±5% 1/16W smd 569-0155-151

R 296 6.8k ohm ±5% 1/16W smd 569-0155-682

R 297 100k ohm ±5% 1/16W smd 569-0155-104

R 298 150 ohm ±5% 1/16W smd 569-0155-151

R 299 6.8k ohm ±5% 1/16W smd 569-0155-682

R 300 100k ohm ±5% 1/16W smd 569-0155-104

R 301 100k ohm ±5% 1/16W smd 569-0155-104

R 302 100k ohm ±5% 1/16W smd 569-0155-104

R 303 6.8k ohm ±5% 1/16W smd 569-0155-682

R 304 68k ohm ±5% 1/16W smd 569-0165-683

R 305 0 ohm jumper 569-0155-001

R 307 100k ohm ±5% 1/16W smd 569-0155-104

R 308 0 ohm jumper 569-0155-001

R 309 100k ohm ±5% 1/16W smd 569-0155-104

R 310 6.8k ohm ±5% 1/16W smd 569-0155-682

R 311 100k ohm ±5% 1/16W smd 569-0155-104

R 312 100k ohm ±5% 1/16W smd 569-0155-104

R 313 100k ohm ±5% 1/16W smd 569-0155-104

R 315 10k ohm ±5% 1/16W smd 569-0155-103

R 316 47k ohm ±5% 1/16W smd 569-0155-473

R 318 10k ohm ±5% 1/16W smd 569-0155-103

R 319 47k ohm ±5% 1/16W smd 569-0155-473

R 320 10k ohm ±5% 1/16W smd 569-0155-103

R 321 10k ohm ±5% 1/16W smd 569-0155-103

R 322 10k ohm ±5% 1/16W smd 569-0155-103

R 323 1k ohm ±5% 1/16W smd 569-0155-102

R 324 10k ohm ±5% 1/16W smd 569-0155-103

R 325 10k ohm ±5% 1/16W smd 569-0155-103

R 326 10k ohm ±5% 1/16W smd 569-0155-103

R 327 10k ohm ±5% 1/16W smd 569-0155-103

R 328 10k ohm ±5% 1/16W smd 569-0155-103

R 329 100 ohm ±5% 1/16W smd 569-0155-101

R330 10k ohm ±5% 1/16W smd 569-0155-103

R331 10k ohm ±5% 1/16W smd 569-0155-103

R332 470 ohm ±5% 1/16W smd 569-0155-471

R333 10k ohm ±5% 1/16W smd 569-0155-103

R334 47k ohm ±5% 1/16W smd 569-0155-473

R336 100 ohm ±5% 1/16W smd 569-0155-101

R338 10k ohm ±5% 1/16W smd 569-0155-103

R339 10k ohm ±5% 1/16W smd 569-0155-103

R 340 47k ohm ±5% 1/16W smd 569-0155-473

R 344 10k ohm ±5% 1/16W smd 569-0155-103

R 345 470 ohm ±5% 1/16W smd 569-0155-471

R 346 10k ohm ±5% 1/16W smd 569-0155-103

R 348 10k ohm ±5% 1/16W smd 569-0155-103

R 350 10k ohm ±5% 1/16W smd 569-0155-103

R 351 47k ohm ±5% 1/16W smd 569-0155-473

R 353 10k ohm ±5% 1/16W smd 569-0155-103

R 355 47k ohm ±5% 1/16W smd 569-0155-473

R 356 10k ohm ±5% 1/16W smd 569-0155-103

R 357 100 ohm ±5% 1/16W smd 569-0155-101

R 358 100 ohm ±5% 1/16W smd 569-0155-101

R 360 10 ohm ±5% 1/16W smd 569-0155-100

R 361 47k ohm ±5% 1/16W smd 569-0155-473

R 362 4.7k ohm ±5% 1/16W smd 569-0155-472

R 364 10k ohm ±5% 1/16W smd 569-0155-103

R 365 10k ohm ±5% 1/16W smd 569-0155-103

R 366 100k ohm ±5% 1/16W smd 569-0155-104

R 367 47k ohm ±5% 1/16W smd 569-0155-473

R 368 10k ohm ±5% 1/16W smd 569-0155-103

R 369 10k ohm ±5% 1/16W smd 569-0155-103

R 370 1k ohm ±5% 1/16W smd 569-0155-102

R 371 10k ohm ±5% 1/16W smd 569-0155-103

R 372 100k ohm ±5% 1/16W smd 569-0155-104

R 373 33.2k ohm ±1% 0.1W smd 569-0151-451

R 374 10k ohm ±5% 1/16W smd 569-0155-103

R 377 10k ohm ±5% 1/16W smd 569-0155-103

R 378 10k ohm ±5% 1/16W smd 569-0155-103

R 379 10k ohm ±5% 1/16W smd 569-0155-103

R 392 10k ohm ±5% 1/16W smd 569-0155-103

R 393 10k ohm ±5% 1/16W smd 569-0155-103

R 394 10k ohm ±5% 1/16W smd 569-0155-103

R 395 10k ohm ±5% 1/16W smd 569-0155-103

R 396 10k ohm ±5% 1/16W smd 569-0155-103
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R 399 100k ohm ±5% 1/16W smd 569-0165-104

R 400 634k ohm ±1% 0.1W smd 569-0151-578

R 401 100k ohm ±1% 0.1W smd 569-0151-501

R 402 100k ohm ±5% 1/16W smd 569-0165-104

R 403 255k ohm ±1% 0.1W smd 569-0151-551

R 404 100k ohm ±1% 0.1W smd 569-0151-501

R 405 10k ohm ±5% 1/16W smd 569-0155-103

R 406 10k ohm ±5% 1/16W smd 569-0155-103

R 407 10k ohm ±5% 1/16W smd 569-0155-103

R 408 10k ohm ±5% 1/16W smd 569-0155-103

R 409 10k ohm ±5% 1/16W smd 569-0155-103

R 410 10k ohm ±5% 1/16W smd 569-0155-103

R 412 100k ohm ±5% 1/16W smd 569-0165-104

R 413 100k ohm ±5% 1/16W smd 569-0165-104

R 683 68k ohm ±5% 1/16W smd 569-0155-683

R 685 27k ohm ±5% 1/16W smd 569-0155-273

R 686 100k ohm ±5% 1/16W smd 569-0165-104

R 687 100k ohm ±5% 1/16W smd 569-0165-104

R 688 51k ohm ±5% 1/16W smd 569-0165-513

R 689 100k ohm ±5% 1/16W smd 569-0165-104

R 690 100k ohm ±5% 1/16W smd 569-0165-104

R 691 100k ohm ±5% 1/16W smd 569-0165-104

R 692 4.7k ohm ±5% 1/16W smd 569-0165-472

R 693 4.7k ohm ±5% 1/16W smd 569-0165-472

R 694 10k ohm ±5% 1/16W smd 569-0165-103

R 695 10k ohm ±5% 1/16W smd 569-0165-103

R 696 10k ohm ±5% 1/16W smd 569-0165-103

R 697 10k ohm ±5% 1/16W smd 569-0165-103

R 698 4.7k ohm ±5% 1/16W smd 569-0165-472

R 699 10k ohm ±5% 1/16W smd 569-0165-103

R 700 10k ohm ±5% 1/16W smd 569-0165-103

R 701 15k ohm ±5% 1/16W smd 569-0165-153

R 702 20k ohm ±5% 1/16W smd 569-0165-203

R 703 30k ohm ±5% 1/16W smd 569-0155-303

R 704 10k ohm ±5% 1/16W smd 569-0165-103

R 705 15k ohm ±5% 1/16W smd 569-0165-153

R 706 20k ohm ±5% 1/16W smd 569-0165-203

R 707 30k ohm ±5% 1/16W smd 569-0155-303

R 709 1k ohm ±5% 1/16W smd 569-0165-102

R 710 1k ohm ±5% 1/16W smd 569-0165-102

R 711 1k ohm ±5% 1/16W smd 569-0165-102

R 712 1k ohm ±5% 1/16W smd 569-0165-102

R 713 10k ohm ±5% 1/16W smd 569-0165-103

R 714 10k ohm ±5% 1/16W smd 569-0165-103

R 715 10k ohm ±5% 1/16W smd 569-0165-103

R 716 1k ohm ±5% 1/16W smd 569-0165-102

R 717 1k ohm ±5% 1/16W smd 569-0165-102

R 718 1k ohm ±5% 1/16W smd 569-0165-102

R 719 1k ohm ±5% 1/16W smd 569-0165-102

R 720 1k ohm ±5% 1/16W smd 569-0165-102

R 721 1k ohm ±5% 1/16W smd 569-0165-102

R 722 4.7k ohm ±5% 1/16W smd 569-0165-472

R 723 4.7k ohm ±5% 1/16W smd 569-0165-472

R 724 15k ohm ±5% 1/16W smd 569-0165-153

R 725 18k ohm ±5% 1/16W smd 569-0165-183

R 726 180 ohm ±5% 1/16W smd 569-0165-181

R 727 180 ohm ±5% 1/16W smd 569-0165-181

R 728 180 ohm ±5% 1/16W smd 569-0165-181

R 729 10k ohm ±5% 1/16W smd 569-0165-103

R 730 24 ohm ±5% 1/16W smd 569-0165-240

R 731 24 ohm ±5% 1/16W smd 569-0165-240

R 732 100k ohm ±5% 1/16W smd 569-0165-104

R 733 7.5k ohm ±1% 1/8W smd 569-0111-385

R 734 7.5k ohm ±1% 1/8W smd 569-0111-385

R 735 10k ohm ±5% 1/16W smd 569-0165-103

R 736 10k ohm ±5% 1/16W smd 569-0165-103

R 737 10k ohm ±5% 1/16W smd 569-0165-103

R 738 51 ohm ±5% 1/16W smd 569-0155-510

R 739 51 ohm ±5% 1/16W smd 569-0155-510

R 740 10k ohm ±5% 1/16W smd 569-0155-103

R 741 100k ohm ±5% 1/16W smd 569-0165-104

R 742 100k ohm ±5% 1/16W smd 569-0165-104

R 744 0 ohm jumper 569-0165-001

R 745 0 ohm jumper 569-0165-001

R 746 0 ohm jumper 569-0165-001

R 747 0 ohm jumper 569-0165-001
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R 748 10 ohm ±5% 1/16W smd 569-0165-100

R 749 10 ohm ±5% 1/16W smd 569-0165-100

R 752 10k ohm ±5% 1/16W smd 569-0165-103

R 753 10k ohm ±5% 1/16W smd 569-0165-103

   

S 001 Switch, momentary norm 
open 

583-9512-002

   

T 001 Isolation transformer 
10BASE-T 

592-9017-003

   

U 001 DSP 
TMS3205510AGGWA1 

544-5003-133

U 002 CODEC, dual 
TLV320AIC211 

544-3016-057

U 003 Schmitt trig, inv TC7S14F-
TE85L 

544-3123-014

U 004 Op Amp OPA340NA 544-2020-023

U 011 Regulator, 5V 400mA 
REG113EA-5 

544-2603-055

U 013 Regulator, 5V 400mA 
REG113EA-5 

544-2603-055

U 015 Regulator, 3.8V, 50 mA 
LP2982 

544-5001-335

U 020 SRAM 256k x 16 
CY62146V  

544-5001-213

U 021 Flash, 8M X 8 bit 
AM29DL640G90 

544-5001-255

U 022 Buffer, quad 74LCX125 544-3776-127

U 023 SRAM 512k x 16 
CY62157CV30 

544-5001-215

U 024 Tri state buffer, 3.3V 
NC7SZ125P5 

544-3914-125

U 025 Buffer, quad 74LCX125 544-3776-127

U 026 3-state buffer, quad 
74ACT125 

544-3776-117

U 027 Schmitt trig, inv TC7S14F-
TE85L 

544-3123-014

U 042 Triple supply monitor 
LT1727 

544-5001-341

U 045 RS-232 bus xcvr 
MAX3221EAE 

544-2023-036

U 046 RS-485 bus transceiver 
ADM483  

544-2023-073

U 048 Bus xcvr, octal 
74LVCC3245 

544-1010-250

U 049 Op am, quad MC3303 544-2020-008

U 056 Multiplexer triple 4053 544-1014-053

U 057 Microcontroller PowerPC 
MPC850 

544-5003-127

U 058 EEPROM 32k x 8 M24256 544-1019-376

U 059 Multiplexer triple 4053 544-1014-053

U 060 Op am, quad MC3303 544-2020-008

U 061 Op am, quad MC3303 544-2020-008

U 063 Flip flop octal 74HC574  544-3764-576

U 064 Flip flop octal 74HC574  544-3764-576

U 065 Flip flop octal 74HC574  544-3764-576

U 066 Multiplexer triple 4053 544-1014-053

U 067 Converter, A/D 8-bit ser 
TLC5481 

544-1010-548

U 069 RS-232 bus xcvr 
MAX3221EAE 

544-2023-036

U 070 Analog switch, SPDT 
NLAS4599 

544-4002-007

U 071 SRAM 512k x 16 
CY62157CV30 

544-5001-215

U 072 SRAM 512k x 16 
CY62157CV30 

544-5001-215

U 073 Tri state buffer, 3.3V 
NC7SZ125P5 

544-3914-125

U 074 DC-DC converter TPS6200 544-4006-011

U 075 DC-DC converter TPS6200 544-4006-011

U 079 Tri state buffer, 3.3V 
NC7SZ125P5 

544-3914-125

U 080 Regulator 5V LT1121IST-5  544-1011-121

U 081 Buffer, quad 74LCX125 544-3776-127

U 082 Programmable logic 544-5001-419

U 083 Op amp, quad OPA4340EA 544-2020-013

U 084 Op amp, quad OPA4340EA 544-2020-013

U 085 Transceiver, 10BASE-T 3V 544-2023-050

U 086 Reg, 3.3V 400 mA 
REG113EA-3.3 

544-2603-056

U 087 Op amp, quad OPA4340EA 544-2020-013

   

Y 002 Crystal, 4.9152 MHz smd  521-3060-022
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Y 003 TCXO, 12.288 MHz smd 518-7012-200

Y 004 Oscillator, 20.000 MHz smd 561-9004-200

   

 FRONT PANEL ASSEMBLY 
Part No. 023-5300-810 

A 151  Plastic front panel assembly  587-9650-002

A 815 Display controller board 023-5300-813

 (see separate listings)  

   

C 750  4.7 µF 10V tantalum smd  510-2624-479

C 754  1.0 µF 35V tantalum smd  510-2628-109

C 755  4.7 µF 10V tantalum smd  510-2624-479

   

DS 700  Dual color, red/grn LED  549-4001-215

DS 
701- 
DS706 

LED, green smd 549-4001-145

DS 
707- 
DS726 

LED, green smd  549-4003-011

DS 727  LCD assembly  549-4501-010

EP 101  Key cap kit (see Section 2.8) 587-5300-001

   

HW 
010  

Washer, .438 x .274 x .030  596-9410-010

HW 
011  

Nut, spanner 3/8 x 7mm  013-1313-018

HW 
012 

Screw, 2-56 x 1/4  575-1602-008

HW 
013 

Lockwasher, internal No. 2 596-2102-006

   

J 703  Connector, 13-pin circular 
recept  

515-1009-025

J 705  Connector, 31-pin  515-7109-129

     

LS 001  Speaker, 2 x 3 in 16-ohm  589-1015-006

     

MP 101 Display bezel  017-2226-046

MP 102 Display gasket  018-1136-120

MP 103 Light pipe  032-0792-032

MP 108 Support-keypad  017-2226-090

MP 151 Gasket, front lens 018-1136-130

MP 152 Control knob  032-0792-010

MP 153 Control knob  032-0792-010

MP 154 Speaker membrane  018-1136-138

MP 155 Spacer, display board  018-1136-140

MP 158 Front panel lens  032-0792-034

MP 160 Spacer (between boards) 013-1188-053

MP 161 Keypad, standard  032-0792-031

MP 162 Speaker retainer  016-2187-250

MP 163 Speaker gasket, silicone 018-1136-128

MP 990 Gasket, microphone jack 
silicone 

018-1136-132

   

NP 001 Johnson label raised  559-9001-310

NP 002 Label, RS 5300 559-5300-100

PC 010 Flex circuit, std push on-off 035-5300-010

 Flex circuit, motorcycle rot 
on-off 

035-5300-015

PC 815 PC board, display 035-5300-815

Q 710  PNP general purpose  576-0003-650

Q 711  NPN general purpose  576-0003-658

Q 712  NPN general purpose  576-0003-658

   

R 800  180k ohm ±5% 1/8W smd  569-0105-184

R 801  100k ohm ±5% 1/8W smd  569-0105-104

R 802  100k ohm ±5% 1/8W smd  569-0105-104

R 803  62 ohm ±5% 2010 .75W smd 569-0135-620

R 804  62 ohm ±5% 2010 .75W smd 569-0135-620

R 805  62 ohm ±5% 2010 .75W smd 569-0135-620

R 806  62 ohm ±5% 2010 .75W smd 569-0135-620

R 807  510 ohm ±5% 1/8W smd  569-0105-511

R 808  62 ohm ±5% 2010 .75W smd 569-0135-620

R 809  62 ohm ±5% 2010 .75W smd 569-0135-620

R 810  510 ohm ±5% 1/8W smd  569-0105-511

R 811  10k ohm ±5% 1/8W smd  569-0105-103

R 812  10k ohm ±5% 1/8W smd  569-0105-103
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S 001  DIP switch, 10-position  583-5100-210

S 154  On-off/Vol push on w/50k 
pot std 

562-0018-075

 On-off/Vol rot on-off , 
motorcycle  

562-0018-077

S 155  Switch rotary and push  583-2042-001

   

U 710  LCD driver, PCF8576TD  544-2027-010

U 711  LCD driver, PCF8576TD  544-2027-010

U 712  Regulator, 8V 0.5A 78M08  544-2003-081

   

W 103  Cable assy, display - logic bd 023-5300-025

   

 DISPLAY CONTROLLER BOARD 

   

C 001 4.7 µF 25V tantalum smd 510-2627-479

C 002 .1 µF ±10% X7R 50V cer 
smd 

510-3675-104

C 003 10 µF 25V tantalum smd 510-2627-100

C 004 .1 µF ±10% X7R 50V cer 
smd 

510-3675-104

C 005 .1 µF ±10% X7R 50V cer 
smd 

510-3675-104

C 006 .1 µF ±10% X7R 50V cer 
smd 

510-3675-104

C 007 .1 µF ±10% X7R 50V cer 
smd 

510-3675-104

C 009 .1 µF ±10% X7R 50V cer 
smd 

510-3675-104

C 010 .1 µF ±10% X7R 50V cer 
smd 

510-3675-104

C 011 .1 µF ±10% X7R 50V cer 
smd 

510-3675-104

C 012 4.7 µF 25V tantalum smd 510-2627-479

C 013 .1 µF ±10% X7R 50V cer 
smd 

510-3675-104

C 016 .1 µF ±10% X7R 50V cer 
smd 

510-3675-104

C 017 4.7 µF 25V tantalum smd 510-2627-479

C 018 .1 µF ±10% X7R 50V cer 
smd 

510-3675-104

C 020 .01µF ±10% X7R cer smd 510-3675-103

C 021 .1 µF ±10% X7R 50V cer 
smd 

510-3675-104

C 022 .1 µF ±10% X7R 50V cer 
smd 

510-3675-104

C 023 .1 µF ±10% X7R 50V cer 
smd 

510-3675-104

C 024 .1 µF ±10% X7R 50V cer 
smd 

510-3675-104

C 029 1.0 µF 10V tantalum smd 510-2624-109

C 030 10 µF 25V tantalum smd 510-2627-100

C 031 4.7 µF 25V tantalum smd 510-2627-479

C 032 .1 µF ±10% X7R 50V cer 
smd 

510-3675-104

C 126 .01 µF ±10% X7R cer smd 510-3675-103

C 127 1.0 µF 10V tantalum smd 510-2624-109

C 128 1.0 µF 10V tantalum smd 510-2624-109

C 129 .1 µF ±10% X7R 50V cer 
smd 

510-3675-104

C 130 .047 µF ±10% X7R cer smd  510-3605-473

   

CR 001 5.6V zener SOT-23 523-2016-569

CR 002 5.6V zener SOT-23 523-2016-569

CR 003 5.6V zener SOT-23 523-2016-569

CR 004 5.6V zener SOT-23 523-2016-569

CR 005 5.6V zener SOT-23 523-2016-569

CR 006 5.6V zener SOT-23 523-2016-569

CR 007 5.6V zener SOT-23 523-2016-569

CR 008 5.6V zener SOT-23 523-2016-569

CR 009 5.6V zener SOT-23 523-2016-569

CR 010 5.6V zener SOT-23 523-2016-569

CR 011 5.6V zener SOT-23 523-2016-569

CR 012 PIN switching diode 523-1504-001

CR 013 5.6V zener SOT-23 523-2016-569

CR 014 PIN switching diode 523-1504-001

   

DS 727 LCD assembly 549-4501-010

F 001 Fuse 2.0 A smd 534-5001-009

   

J 700  Connector, 16-pin  515-7000-668
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J 701  Connector, micro-miniature  515-7113-073

J 702  Connector, 9-pin ZIF flex  515-7111-321

J 704 Connector, 5-pin (PA bd 
cable) 

515-7111-254

   

PC 001 PC board, display controller 
rev. 5 

035-5300-810 5

   

Q 002 NPN general purpose 576-0003-658

Q 004 NPN digital w/resistors 576-0003-616

Q 005 NPN digital w/resistors 576-0003-616

Q 006 NPN digital w/resistors 576-0003-616

   

R 002 330k ohm ±5% 1/16W smd 569-0155-334

R 003 10k ohm ±5% 1/16W smd 569-0155-103

R 005 100k ohm ±5% 1/16W smd 569-0155-104

R 006 10k ohm ±5% 1/16W smd 569-0155-103

R 007 10k ohm ±5% 1/16W smd 569-0155-103

R 008 10k ohm ±5% 1/16W smd 569-0155-103

R 009 10k ohm ±5% 1/16W smd 569-0155-103

R 010 10k ohm ±5% 1/16W smd 569-0155-103

R 011 47k ohm ±5% 1/16W smd 569-0155-473

R 012 47k ohm ±5% 1/16W smd 569-0155-473

R 013 47k ohm ±5% 1/16W smd 569-0155-473

R 014 47k ohm ±5% 1/16W smd 569-0155-473

R 015 200k ohm ±5% 1/16W smd 569-0155-204

R 016 200k ohm ±5% 1/16W smd 569-0155-204

R 017 47k ohm ±5% 1/16W smd 569-0155-473

R 018 47k ohm ±5% 1/16W smd 569-0155-473

R 019 300 ohm ±5% 1/8W smd 569-0105-301

R 020 47k ohm ±5% 1/16W smd 569-0155-473

R 021 100k ohm ±5% 1/16W smd 569-0155-104

R 022 300 ohm ±5% 1/8W smd 569-0105-301

R 023 10k ohm ±5% 1/16W smd 569-0155-103

R 024 10k ohm ±5% 1/16W smd 569-0155-103

R 025 10k ohm ±5% 1/16W smd 569-0155-103

R 026 10k ohm ±5% 1/16W smd 569-0155-103

R 027 51 ohm ±5% 1/8W smd 569-0105-510

R 028 100k ohm ±5% 1/16W smd 569-0155-104

R 029 100k ohm ±5% 1/16W smd 569-0155-104

R 030 10k ohm ±5% 1/16W smd 569-0155-103

R 031 300ohm ±5% 1/16W smd 569-0155-301

R 032 47k ohm ±5% 1/16W smd 569-0155-473

R 033 47k ohm ±5% 1/16W smd 569-0155-473

R 035 47k ohm ±5% 1/16W smd 569-0155-473

R 036 620 ohm ±5% 1/8W smd 569-0105-621

R 037 620 ohm ±5% 1/8W smd 569-0105-621

R 038 47k ohm ±5% 1/16W smd 569-0155-473

R 039 300ohm ±5% 1/16W smd 569-0155-301

R 040 10k ohm ±5% 1/16W smd 569-0155-103

R 041 3.3k ohm ±5% 1/16W smd 569-0155-332

R 042 10k ohm ±5% 1/16W smd 569-0155-103

R 043 4.7k ohm ±5% 1/16W smd 569-0155-472

R 044 10k ohm ±5% 1/16W smd 569-0155-103

R 045 10k ohm ±5% 1/16W smd 569-0155-103

R 046 47k ohm ±5% 1/16W smd 569-0155-473

R 047 10k ohm ±5% 1/16W smd 569-0155-103

R 048 47k ohm ±5% 1/16W smd 569-0155-473

R 049 47k ohm ±5% 1/16W smd 569-0155-473

R 050 47k ohm ±5% 1/16W smd 569-0155-473

R 051 47k ohm ±5% 1/16W smd 569-0155-473

R 052 47k ohm ±5% 1/16W smd 569-0155-473

R 054 10k ohm ±5% 1/16W smd 569-0155-103

R 055 4.7k ohm ±5% 1/16W smd 569-0155-472

R 056 10k ohm ±5% 1/16W smd 569-0155-103

R 057 4.7k ohm ±5% 1/16W smd 569-0155-472

R 058 10k ohm ±5% 1/16W smd 569-0155-103

R 059 47k ohm ±5% 1/16W smd 569-0155-473

R 060 47k ohm ±5% 1/16W smd 569-0155-473

R 061 47k ohm ±5% 1/16W smd 569-0155-473

R 062 10k ohm ±5% 1/16W smd 569-0155-103

R 063 10k ohm ±5% 1/16W smd 569-0155-103

R 064 10k ohm ±5% 1/16W smd 569-0155-103

R 065 10k ohm ±5% 1/16W smd 569-0155-103

R 066 3.3k ohm ±5% 1/16W smd 569-0155-332

R 067 47k ohm ±5% 1/16W smd 569-0155-473
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R 068 10k ohm ±5% 1/16W smd 569-0155-103

R 069 10k ohm ±5% 1/16W smd 569-0155-103

R 070 10k ohm ±5% 1/16W smd 569-0155-103

R 071 47k ohm ±5% 1/16W smd 569-0155-473

R 072 10k ohm ±5% 1/16W smd 569-0155-103

R 073 10k ohm ±5% 1/16W smd 569-0155-103

R 074 10k ohm ±5% 1/16W smd 569-0155-103

R 075 10k ohm ±5% 1/16W smd 569-0155-103

R 076 10k ohm ±5% 1/16W smd 569-0155-103

R 077 10k ohm ±5% 1/16W smd 569-0155-103

R 078 10k ohm ±5% 1/16W smd 569-0155-103

R 079 5.1kohm ±5% 1/16W smd 569-0155-512

R 080 300ohm ±5% 1/16W smd 569-0155-301

R 082 47k ohm ±5% 1/16W smd 569-0155-473

R 083 3.3k ohm ±5% 1/16W smd 569-0155-332

R 084 10k ohm ±5% 1/16W smd 569-0155-103

R 085 100k ohm ±5% 1/16W smd 569-0155-104

R 087 10k ohm ±5% 1/16W smd 569-0155-103

R 089 1k ohm ±5% 1/16W smd 569-0155-102

R 090 10k ohm ±5% 1/16W smd 569-0155-103

R 091 10k ohm ±5% 1/16W smd 569-0155-103

R 092 10k ohm ±5% 1/16W smd 569-0155-103

R 093 10k ohm ±5% 1/16W smd 569-0155-103

R 094 10k ohm ±5% 1/16W smd 569-0155-103

R 095 10k ohm ±5% 1/16W smd 569-0155-103

R 096 10k ohm ±5% 1/16W smd 569-0155-103

R 097 10k ohm ±5% 1/16W smd 569-0155-103

R 098 10k ohm ±5% 1/16W smd 569-0155-103

R 099 10k ohm ±5% 1/16W smd 569-0155-103

R 100 10k ohm ±5% 1/16W smd 569-0155-103

R 101 10k ohm ±5% 1/16W smd 569-0155-103

R 102 10k ohm ±5% 1/16W smd 569-0155-103

R 103 1.2M ohm ±5% 1/16W smd 569-0155-125

R 104 200k ohm ±5% 1/16W smd 569-0155-204

R 105 240k ohm ±5% 1/16W smd 569-0155-244

R 107 82k ohm ±5% 1/16W smd 569-0155-823

R 108 160k ohm ±5% 1/16W smd 569-0155-164

R 109 1k ohm ±5% 1/16W smd 569-0155-102

R 110 10k ohm ±5% 1/16W smd 569-0155-103

R 111 47k ohm ±5% 1/16W smd 569-0155-473

R 112 100k ohm ±5% 1/16W smd 569-0155-104

R 113 100k ohm ±5% 1/16W smd 569-0155-104

R 114 100k ohm ±5% 1/16W smd 569-0155-104

R 115 1k ohm ±5% 1/16W smd 569-0155-102

R 116 47k ohm ±5% 1/16W smd 569-0155-473

   

U 002 Op am, quad MC3303 544-2020-008

U 003 RS-485 driver SN65176  544-2023-027

U 009 Microcontroller 
MC68HC908 

544-9100-007

U 012 5V regulator, 300 mA 
ADP3367  

544-2032-009

U 045 3-state noninv amp 
TC74VHC125 

544-3991-125

U 047 5V regulator, 300 mA 
ADP3367 

544-2032-009

U 054 Schmitt trigger, hex 74HC14 544-3991-014

U 055 Flip-flop, dual 74HC74  544-3991-074

U 056 Buffer, open drain hex 
MM74C906 

544-3716-906

   

Y 002 4.9152 MHz crystal  521-3060-024

   

REMOTE CONTROL UNIT 
UNIQUE PARTS 

A 001 Remote audio amp bd assy 
(rev) 

023-5300-751

 Remote audio amp bd assy 
(unrev) 

023-5300-750

 (see separate listing which 
follows) 

 

A 002 Front panel assembly 023-5300-810

 (see preceding listing)  

A 755 Audio PA board cable 023-5300-755

HW 
001 

Washer, poly 0.937 diameter 596-6400-015

HW 
002 

Washer, SS spring 3/4 OD 596-9260-001

HW Screw, captive pan head .75 575-9606-018
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003 

MP 001 Knob, remote control unit 032-0792-015

MP 002 Mounting bracket, rem ctrl 
unit 

017-2226-050

MP 003 Gasket 032-0792-066

MP 005 Housing, remote control unit 032-0792-130

MP 006 Rear cover, remote control 
unit 

032-0792-135

NP 002 Johnson label 559-9001-310

W 003 Control cable, 17-ft 597-2002-262

 Control cable, 8-ft 
motorcycle 

597-2002-259

 Control cable, 50-ft 597-2002-263

W 104 Control unit pigtail cable, std 597-2002-264

 Ctrl unit pigtail cable, 
motorcycle 

597-2002-274

AUDIO AMP BOARD (REVISED) 
Part No. 023-5300-751 

C 001 15 µF 20V tantalum smd 510-2626-150

C 002 15 µF 20V tantalum smd 510-2626-150

C 003 0.1 µF X7R ±10% 50V cer 
smd 

510-3606-104

C 004 1 µF 35V tantalum smd 510-2628-109

C 005 0.1 µF X7R ±10% 50V cer 
smd 

510-3606-104

J 001 Header, 2-pin right angle 515-7100-602

J 002 Connector, 5-pin 515-7111-254

PC 001 PC board, audio amp revised 035-5300-75002

Q 001 NPN general purpose smd 576-0003-616

R 001 7.5k ohm ±5% 1/8W smd 569-0155-752

R 003 10k ohm ±5% 1/8W smd 569-0155-103

U 001 Audio amp, 3W TDA7056A 544-2006-025

 Std. DC Power Cable Assembly
Part No. 023-9750-010 

   

A 001 Fused DC power cable 023-9650-008

 (see separate listing)  

A 002 Mic clip ground wire 023-7171-911

EP 002 Ring terminal, 3/4 10-12 
AWG  

586-0001-036

EP 003 Ring terminal, 3/8 10-12 
AWG 

586-0001-019

F 101 Fuse, 15 amp 32V 534-0003-038

HW 
000 

Key extraction tool 017-2226-000

HW 
002 

Screw, 4-40 x 3/8 pan head 
(1) 

575-0604-012

HW 
003 

Screw, 4-24 x 1/4 phil (3) 575-3604-008

HW 
004 

Screw, 4-20 x 5/8 phil (3) 575-5604-020

MP 001 Heavy-duty mic clip 023-3514-001

Fused DC Power Cable 
Part No. 023-9650-008 

EP 101 Female crimp pin 515-9032-540

FH 001 Fuse holder in-line includes:  

   Contact 534-1004-037

   Body 534-1004-031

   Knob 534-1004-032

   Spring 534-1004-035

HW 
101 

Wire seal 574-9025-035

ML 001 Negative ground warning tag 559-4014-001

ML 002 Jump start warning label 559-4057-010

P 101 2-pin female power 
connector 

515-9032-535

W 101 Wire, 12 AWG stranded blue 597-7021-206

W 102 Wire, 12 AWG stranded red 597-7021-202

   

Accessory Wire Harness Kit 
Part No. 023-9750-011 

 Fuseholder components:  

EP 001  Contact 586-9004-001

F 001  Fuse, 1A 250V FB AGC 534-0003-020

MP001  Fuseholder body 534-1004-031

MP002  Fuseholder knob 534-1004-032

MP003  Fuseholder spring 534-1004-035

HW 
001 

Pin contact, crimp type 515-1501-055

P 101 8-pin receptacle housing 515-1501-050
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 Front Mounting Bracket 
Assembly 

Part No. 023-9750-012 
HW 
001 

Self-drilling screw 1/4 (4) 575-9077-565

HW 
002 

Self-drilling screw #10 (4) 575-9077-545

MP 101 Knob 10-32 1/2 547-0016-007

MP 201 Transceiver mounting 
bracket 

017-2226-034

Amplified Dynamic Microphone
Part No. 250-0740-310 

C 001  3.3 µF 16V tantalum chip  510-2625-339

C 002  220 pF ±5% NPO 50V cer 
chip  

510-3602-221

EP001  Contact .038" diameter  586-9008-100

EP002  Mic cord w/Hirose connector 597-2002-255

EP004  Terminal (on hanger)  022-0069-011

HW001 Screw 4-20 x 3/8  575-5604-012

HW004 Screw 2-56 x 3/8  575-1602-012

MK001 Dynamic mic cartridge  589-1011-003

MP001  Case front black  032-0426-100

MP002  Case back black  032-0427-100

MP003  Actuator black  032-0428-050

MP004  Cartridge gasket  032-0429-075

MP005  Blast filter  018-1033-002

MP006  Switch bracket  017-1885-030

MP007  Hanger button  013-1216-005

MP008  Crimp retainer  017-2222-006

MP009  Rubber bumper  018-0798-009

MP010  Backing plate  015-0876-026

MP011  Strain relief, mic cord  032-0429-086

MP012  Shim support, rubber bumper 017-2222-007

MP020 Foam support 018-0798-012

NP001  Nameplate  559-0039-026

PC001  PC board, amplifier  035-0441-020

Q 001  NPN amplifier SOT-23  576-0003-658

R 001  51k ohm ±5% 1/8W chip  569-0115-513

R 002  18 ohm ±5% 1/8W chip  569-0115-180

S 001  Leaf switch SPST  583-1004-031

15 Watt, 4.0-Ohm Speaker 
(Black) 

Part No. 250-0151-006 
HW001 Strain relief (in case back)  574-0003-008

HW002 Screw, self drilling 574-9077-543

HW003 Screw, 4-20 x 1/2 pan head  575-5604-016

HW005 Foam gasket  018-1126-001

HW006 Urethane foam, 1/16 thick 042-0361-318

HW008 Screw, 6-19 x 1/4 pan hd 
phillips 

575-5606-008

HW009 Terminal lug 586-0005-106

LS001 Speaker, 5'' 15W 4.0 ohm  589-1016-003

MP001 Case front (black)  032-0758-004

MP002 Case back (black)  032-0759-004

MP003 Mounting bracket (black)  032-0760-004

MP004 Tri knob 10-32  547-0016-004

NP001 Overlay, speaker front  559-0072-010

P 001  Crimp wire contact 515-5010-055

W 001 Speaker wire, 22 AWG (6 ft 
used) 

597-2006-002

15W 4.0-Ohm Motorcycle 
Speaker 

Part No. 250-0151-015 
HW001 Strain relief (in case back)  574-0003-008

  Rubber switch boot 574-3500-153

HW002 Screw, self drilling 574-9077-543

HW003 Screw, 4-20 x 1/2 pan head  575-5604-016

HW005 Foam gasket  018-1126-001

HW006 Urethane foam, 1/16 thick 042-0361-318

HW008 Screw, 6-19 x 1/4 pan hd 
phillips 

575-5606-008

HW009 Terminal lug 586-0005-106

LS001 Speaker, 5'' 15W 4.0 ohm  589-1016-003

MP001 Case front (black)  032-0758-004

MP002 Case back, motorcycle 
(black)  

032-0759-006

MP003 Mounting bracket (black)  032-0760-004
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MP004  Tri knob 10-32  547-0016-004

NP001  Overlay, speaker front  559-0072-010

S 001 Switch, SPST toggle 583-0006-061

W 001  Speaker wire, motorcycle 023-0151-011
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Ref No. Description Part No. 

HANDHELD CONTROL UNIT 
Part No. 250-5300-101 

   

A 001 Main board assembly 023-5300-705

A 002 Keypad board assembly 023-5300-707

A 130 Junction box assembly 023-5300-130

 (see separate listing)  

   

C 001 4.7 µF 25V tantalum smd  510-2627-479

C 002 0.1 µF ±10% X7R 25V cer 
smd 

510-3675-104

C 003 10 µF 25V tantalum smd 510-2627-100

C 005 0.1 µF ±10% X7R 25V cer 
smd 

510-3675-104

C 007 0.1 µF ±10% X7R 25V cer 
smd 

510-3675-104

C 008 33 pF ±5% NPO 25V cer 
smd 

510-3674-330

C 009 0.1 µF ±10% X7R 25V cer 
smd 

510-3675-104

C 010 0.1 µF ±10% X7R 25V cer 
smd 

510-3675-104

C 011 0.1 µF ±10% X7R 25V cer 
smd 

510-3675-104

C 013 0.1 µF ±10% X7R 25V cer 
smd 

510-3675-104

C 014 0.01 µF ±10% X7R 25V 
cer smd 

510-3675-103

C 015 0.01 µF ±10% X7R 25V 
cer smd 

510-3675-103

C 016 0.1 µF ±10% X7R 25V cer 
smd 

510-3675-104

C 017 4.7 µF 25V tantalum smd 510-2627-479

C 018 0.1 µF ±10% X7R 25V cer 
smd 

510-3675-104

C 019 390 pF ±5% NPO 25V cer 
smd 

510-3674-391

C 020 0.01 µF ±10% X7R 25V 
cer smd 

510-3675-103

C 021 0.1 µF ±10% X7R 25V cer 510-3675-104

smd 

C 022 0.1 µF ±10% X7R 25V cer 
smd 

510-3675-104

C 023 0.1 µF ±10% X7R 25V cer 
smd 

510-3675-104

C 025 180 pF ±5% NPO 25V cer 
smd 

510-3674-181

C 029 1.0 µF 10V tantalum smd 510-2624-109

C 030 10 µF 25V tantalum smd 510-2627-100

C 031 4.7 µF 20V tantalum smd 510-2626-479

C 032 0.1 µF ±10% X7R 25V cer 
smd 

510-3675-104

C 126 0.01 µF ±10% X7R 25V 
cer smd 

510-3675-103

C 127 1.0 µF 10V tantalum smd 510-2624-109

C 128 1.0 µF 10V tantalum smd 510-2624-109

C 129 0.1 µF ±10% X7R 25V cer 
smd 

510-3675-104

C 130 4.7 µF 25V tantalum smd 510-2627-479

C 131 10 µF 25V tantalum smd 510-2627-100

C 132 0.1 µF ±10% X7R 25V cer 
smd 

510-3675-104

C 133 10 µF 25V tantalum smd 510-2627-100

C 134 10 µF 25V tantalum smd 510-2627-100

C 135 4.7 µF tantalum smd  510-2622-479

C 136 0.1 µF ±10% X7R 25V cer 
smd 

510-3675-104

C 137 0.1 µF ±10% X7R 25V cer 
smd 

510-3675-104

C 138 1.0 µF 35V tantalum smd 510-2628-109

C 139 0.22 F 5.5V electrolytic  510-9510-055

C 140 10 µF 25V tantalum smd 510-2627-100

C 141 0.1 µF ±10% X7R 25V cer 
smd 

510-3675-104

C 142 0.1 µF ±10% X7R 25V cer 
smd 

510-3675-104

C 143 0.1 µF ±10% X7R 25V cer 
smd 

510-3675-104

C 144 0.047 µF X7R ±10% cer 
smd 

510-3605-473

C 145 0.1 µF ±10% X7R 25V cer 
smd 

510-3675-104
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C 146 0.1 µF ±10% X7R 25V cer 
smd 

510-3675-104

   

CR 004- 5.6V zener 523-2016-569

 CR 11   

CR 012 Pin switching diode 523-1504-001

CR 013 5.6V zener 523-2016-569

CR 020 5.6V zener 523-2016-569

CR 021 5.6V zener 523-2016-569

CR 023 5.6V zener 523-2016-569

CR 024 Dual color LED, red/grn 549-4001-215

CR 025- 5.6V zener 523-2016-569

 CR 29   

CR 030 Dual diodes, com anodes 523-1504-024

CR 031 Dual diodes, com anodes 523-1504-024

CR 033 Dual diodes, com anodes 523-1504-024

CR 034 Dual diodes, com anodes 523-1504-024

   

DS 001 LCD, glass  549-4501-011

DS 002 Fiber optics, backing  549-4501-032

DS 024 LED, green 549-4003-011

DS27-35 LED, green 549-4003-011

EP 001 Spade terminal #6 586-0003-034

HW 01a Screw, 6-32 x 5/16 575-1606-010

HW 01b Spacer, keypad board 013-1188-055

HW 01c Screw, 4-40 x 1/4  575-1604-008

HW 02a Screw, 2-56 x 5/8 Torx 
black 

575-8002-020

HW 02b Washer, split lock #4  596-1304-008

HW 003 Lockwasher, internal #6 596-1106-009

J 003 Connector, 12-pin socket 
.100 

515-5300-001

MK 001 Microphone cartridge 589-0301-003

   

MP 01a Mic hanger button 013-1216-007

MP 01b Display bezel 017-2226-048 3

MP 01c Mic element isolator  032-0757-834

MP 02a Back housing  032-0792-056

MP 02b Backplate, fiber optic 032-0792-054

backlighting  

MP 03a Keypad, rubber revised 032-0792-059 2

MP 03b Elastomeric connector  515-9900-010

MP 004 Fiber sheet 12 x 21 058-0021-002

MP 005 Fiber sheet 12 x 21 058-0021-002

   

MP 006 Gasket seal assembly 587-0792-048

MP 008 Front housing assembly 587-0792-058

MP 009 Water barrier, microphone 574-5300-001

MP 010 Lens, front housing 032-0792-052

MP 011 Lens gasket, front housing 574-3500-080

MP 012 Lens PSA, front housing 574-3500-082

   

NP 001 Label, EFJ logo front 559-5000-550

   

P 001 Connector, 11-pin single 
row 

515-9036-021

P 003 Connector, 12-pin single 
row 

515-5300-003

   

PC 001 Main PC board, rev 3 035-5300-700 3

PC 001 Keypad board, rev 0 035-5300-707

   

Q 002 NPN general purpose 576-0003-658

Q 004 NPN digital w/resistors  576-0003-616

Q 005 NPN digital w/resistors 576-0003-616

Q 006 NPN digital w/resistors 576-0003-616

Q 007 NPN general purpose 576-0003-658

Q 008 NPN general purpose 576-0003-658

Q 009 NPN general purpose 576-0003-658

Q 010 PNP general purpose 576-0003-650

Q 012 Power MOSFET 20 volt 576-0006-243

Q 013 Power MOSFET 20 volt 576-0006-243

   

R 002 330k ohm ±5% 1/16W smd 569-0155-334

R 003 10k ohm ±5% 1/16W smd 569-0155-103

R 005 100k ohm ±5% 1/16W smd 569-0155-104

R 006 47k ohm ±5% 1/16W smd 569-0155-473
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R 007 47k ohm ±5% 1/16W smd 569-0155-473

R 008 47k ohm ±5% 1/16W smd 569-0155-473

R 009 47k ohm ±5% 1/16W smd 569-0155-473

R 010 47k ohm ±5% 1/16W smd 569-0155-473

R 011 2.2k ohm ±5% 1/16W smd 569-0155-222

R 012 2.2k ohm ±5% 1/16W smd 569-0155-222

R 013 2.2k ohm ±5% 1/16W smd 569-0155-222

R 015 200k ohm ±5% 1/16W smd 569-0155-204

R 016 200k ohm ±5% 1/16W smd 569-0155-204

R 017 2.2k ohm ±5% 1/16W smd 569-0155-222

R 018 2.2k ohm ±5% 1/16W smd 569-0155-222

R 019 300 ohm ±5% 1/8W smd 569-0105-301

R 021 100k ohm ±5% 1/16W smd 569-0155-104

R 022 300 ohm ±5% 1/8W smd 569-0105-301

R 028 100k ohm ±5% 1/16W smd 569-0155-104

R 029 100k ohm ±5% 1/16W smd 569-0155-104

R 034 2.2k ohm ±5% 1/16W smd 569-0155-222

R 040 10k ohm ±5% 1/16W smd 569-0155-103

R 042 10k ohm ±5% 1/16W smd 569-0155-103

R 043 4.7kohm ±5% 1/16W smd 569-0155-472

R 044 10k ohm ±5% 1/16W smd 569-0155-103

R 045 10k ohm ±5% 1/16W smd 569-0155-103

R 046 47k ohm ±5% 1/16W smd 569-0155-473

R 047 10k ohm ±5% 1/16W smd 569-0155-103

R 051 47k ohm ±5% 1/16W smd 569-0155-473

R 052 47k ohm ±5% 1/16W smd 569-0155-473

R 053 33k ohm ±5% 1/16W smd 569-0155-333

R 054 10k ohm ±5% 1/16W smd 569-0155-103

R 055 4.7k ohm ±5% 1/16W smd 569-0155-472

R 056 10k ohm ±5% 1/16W smd 569-0155-103

R 057 4.7k ohm ±5% 1/16W smd 569-0155-472

R 058 10k ohm ±5% 1/16W smd 569-0155-103

R 059 2.2k ohm ±5% 1/16W smd 569-0155-222

R 060 2.2k ohm ±5% 1/16W smd 569-0155-222

R 061 2.2k ohm ±5% 1/16W smd 569-0155-222

R 062 10k ohm ±5% 1/16W smd 569-0155-103

R 063 10k ohm ±5% 1/16W smd 569-0155-103

R 064 10k ohm ±5% 1/16W smd 569-0155-103

R 065 10k ohm ±5% 1/16W smd 569-0155-103

R 066 3.3k ohm ±5% 1/16W smd 569-0155-332

R 067 2.2k ohm ±5% 1/16W smd 569-0155-222

R 068 10k ohm ±5% 1/16W smd 569-0155-103

R 069 10k ohm ±5% 1/16W smd 569-0155-103

R 070 10k ohm ±5% 1/16W smd 569-0155-103

R 071 2.2k ohm ±5% 1/16W smd 569-0155-222

R 072 47k ohm ±5% 1/16W smd 569-0155-473

R 073 47k ohm ±5% 1/16W smd 569-0155-473

R 074 47k ohm ±5% 1/16W smd 569-0155-473

R 075 47k ohm ±5% 1/16W smd 569-0155-473

R 076 47k ohm ±5% 1/16W smd 569-0155-473

R 077 10k ohm ±5% 1/16W smd 569-0155-103

R 078 10k ohm ±5% 1/16W smd 569-0155-103

R 079 5.1k ohm ±5% 1/16W smd 569-0155-512

R 080 300 ohm ±5% 1/16W smd 569-0155-301

R 082 47k ohm ±5% 1/16W smd 569-0155-473

R 083 3.3k ohm ±5% 1/16W smd 569-0155-332

R 084 10k ohm ±5% 1/16W smd 569-0155-103

R 087 10k ohm ±5% 1/16W smd 569-0155-103

R 090 10k ohm ±5% 1/16W smd 569-0155-103

R 093 10k ohm ±5% 1/16W smd 569-0155-103

R 095 10k ohm ±5% 1/16W smd 569-0155-103

R 096 10k ohm ±5% 1/16W smd 569-0155-103

R 097 10k ohm ±5% 1/16W smd 569-0155-103

R 098 10k ohm ±5% 1/16W smd 569-0155-103

R 099 10k ohm ±5% 1/16W smd 569-0155-103

R 100 10k ohm ±5% 1/16W smd 569-0155-103

R 101 10k ohm ±5% 1/16W smd 569-0155-103

R 102 10k ohm ±5% 1/16W smd 569-0155-103

R 103 1.2M ohm ±5% 1/16W 
smd 

569-0155-125

R 104 200k ohm ±5% 1/16W smd 569-0155-204

R 105 240k ohm ±5% 1/16W smd 569-0155-244

R 106 47k ohm ±5% 1/16W smd 569-0155-473

R 107 82k ohm ±5% 1/16W smd 569-0155-823

R 108 160k ohm ±5% 1/16W smd 569-0155-164

R 109 1k ohm ±5% 1/16W smd 569-0155-102
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R 110 10k ohm ±5% 1/16W smd 569-0155-103

R 111 47k ohm ±5% 1/16W smd 569-0155-473

R 112 100k ohm ±5% 1/16W smd 569-0155-104

R 113 100k ohm ±5% 1/16W smd 569-0155-104

R 114 100k ohm ±5% 1/16W smd 569-0155-104

R 115 1k ohm ±5% 1/16W smd 569-0155-102

R 116 47k ohm ±5% 1/16W smd 569-0155-473

R 118 10k ohm ±5% 1/16W smd 569-0155-103

R 119 2.2k ohm ±5% 1/16W smd 569-0155-222

R 120 2.2k ohm ±5% 1/16W smd 569-0155-222

R 121 10k ohm ±5% 1/16W smd 569-0155-103

R 122 47k ohm ±5% 1/16W smd 569-0155-473

R 123 47k ohm ±5% 1/16W smd 569-0155-473

R 124 10k ohm ±5% 1/16W smd 569-0155-103

R 125 2.2k ohm ±5% 1/16W smd 569-0155-222

R 126 510 ohm ±5% 1/8W smd 569-0115-511

R 127 10k ohm ±5% 1/16W smd 569-0155-103

R 128 510 ohm ±5% 1/8W smd 569-0115-511

R 129 100k ohm ±5% 1/16W smd 569-0155-104

R 130 150 ohm ±5% 3/4W smd 569-0135-151

R 131 150 ohm ±5% 3/4W smd 569-0135-151

R 134 100 ohm ±5% 3/4W smd 569-0135-101

R 135 100 ohm ±5% 3/4W smd 569-0135-101

R 136 100 ohm ±5% 3/4W smd 569-0135-101

R 137 100 ohm ±5% 3/4W smd 569-0135-101

R 138 4.7k ohm ±5% 1/16W smd 569-0155-472

R 139 4.7k ohm ±5% 1/16W smd 569-0155-472

R 140 100k ohm ±5% 1/16W smd 569-0155-104

R 141 100k ohm ±5% 1/16W smd 569-0155-104

R 142 100k ohm ±5% 1/16W smd 569-0155-104

R 143 100k ohm ±5% 1/16W smd 569-0155-104

R 144 100k ohm ±5% 1/16W smd 569-0155-104

R 145 180k ohm ±5% 1/16W smd 569-0155-184

R 146 100k ohm ±5% 1/16W smd 569-0155-104

R 147 100k ohm ±5% 1/16W smd 569-0155-104

R 150 10k ohm ±5% 1/16W smd 569-0155-103

R 151 10k ohm ±5% 1/16W smd 569-0155-103

R 152 10k ohm ±5% 1/16W smd 569-0155-103

R 153 1k ohm ±5% 1/8W smd 569-0115-102

R 154 1k ohm ±5% 1/8W smd 569-0115-102

R 155 1k ohm ±5% 1/8W smd 569-0115-102

R 156 1k ohm ±5% 1/8W smd 569-0115-102

   

S 001 10 Pos DIP switch 583-5100-210

S 022 Light touch switch  583-4020-015

S 027 Light touch switch 583-4020-015

S 029 Light touch switch 583-4020-015

S 030 KT series switch, right 
angle 

583-9228-003

   

U 002 Op amp, quad MC3303 544-2020-008

U 003 RS-485 bus transceiver 
ADM483 

544-2023-073

U 009 Microcontroller 
MC68HC908 

544-9100-007

U 012 Regulator, 5V 300mA 
ADP3367 

544-2032-009

U 045 Non-inverting buffer, quad 
TC74VHC125 

544-3991-125

U 047 Regulator, 5V 300mA 
ADP3367 

544-2032-009

U 054 Schmitt trigger, hex 74C14 544-3991-014

U 056 Open drain buffer, hex 
74C906 

544-3716-906

U 057 Regulator, 5V 300mA 
ADP3367 

544-2032-009

U 058 Regulator, 8V 0.5A 78M08 544-2003-081

U 059 Univ LCD driver PCF8576 544-2027-010

U 060 Univ LCD driver PCF8576 544-2027-010

U 061 Voltage reference, 2.5V 
LM4120 

544-2032-008

U 062 D flip-flop TC7W74FU  544-1010-014

U 063 D flip-flop TC7W74FU 544-1010-014

   

W 001 Coil cord assembly 597-2002-272

W 503 Control cable, 17 ft. junc - 
xcvr  

597-2002-267

Y 002 Crystal, 4.9152 MHz smd 521-3060-024
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HHC Junction Box Assembly 
Part No. 023-5300-130 

C 001 2.2 uF 20V tantalum smd  510-2626-229

C 002 0.1 µF ±10% X7R 25V cer 
smd 

510-3675-104

C 003 0.1 µF ±10% X7R 25V cer 
smd 

510-3675-104

C 004 2.2 uF 20V tantalum smd 510-2626-229

C 005 0.1 µF ±10% X7R 25V cer 
smd 

510-3675-104

C 006 0.1 µF ±10% X7R 25V cer 
smd 

510-3675-104

C 008 0.1 µF ±10% X7R 25V cer 
smd 

510-3675-104

C 009 0.1 µF ±10% X7R 25V cer 
smd 

510-3675-104

C 010 0.1 µF ±10% X7R 25V cer 
smd 

510-3675-104

C 011 0.1 µF ±10% X7R 25V cer 
smd 

510-3675-104

C 012 1µF X7R ±10% 16V cer 
smd 

510-3606-105

C 013 1µF X7R ±10% 16V cer 
smd 

510-3606-105

C 014 1µF X7R ±10% 16V cer 
smd 

510-3606-105

C 015 0.1 µF ±10% X7R 25V cer 
smd 

510-3675-104

C 016 0.1 µF ±10% X7R 25V cer 
smd 

510-3675-104

C 018 0.1 µF ±10% X7R 25V cer 
smd 

510-3675-104

C 019 0.1 µF ±10% X7R 25V cer 
smd 

510-3675-104

C 020 0.1 µF ±10% X7R 25V cer 
smd 

510-3675-104

C 021 0.1 µF ±10% X7R 25V cer 
smd 

510-3675-104

C 022 1µF X7R ±10% 16V cer 
smd 

510-3606-105

C 023 2.2 uF 35V tantalum smd  510-2628-338

C 024 10 uF 25V tantalum smd 510-2627-100

C 025 0.1 µF ±10% X7R 25V cer 
smd 

510-3675-104

C 026 0.1 µF ±10% X7R 25V cer 
smd 

510-3675-104

C 027 0.1 µF ±10% X7R 25V cer 
smd 

510-3675-104

C 028 1µF X7R ±10% 16V cer 
smd 

510-3606-105

C 029 0.1 µF ±10% X7R 25V cer 
smd 

510-3675-104

C 030 0.1 µF ±10% X7R 25V cer 
smd 

510-3675-104

   

F 001 Fuse 2.0 A smd 534-5001-009

HW 001 Spacer, 4-40 Hex male/fem 013-1160-103

HW 002 Screw, 4-40 x .25  575-0604-008

HW 003 Screw, 8-18 hex hd sht mtl  575-3908-016

HW 004 Polarizing key box cnt 515-7109-010

   

J 001 Connector, 10-pin  515-7104-005

J 002 Connector, 15-pin PC mt 
female 

515-0506-115

J 003 Connector, 15-pin 515-0506-119

J 005 3.6 mm (1/8) jack enclosed 515-2001-011

J 006 3.6 mm (1/8) jack enclosed 515-2001-011

J 007 2.5 mm (3/32) audio jack, 
stereo 

515-2002-040

   

MP 002 Extrusion  014-0777-023

MP 003 Front Panel  017-5300-001

MP 004 Back Panel, revision 2 017-5300-003 2

MP 005 Mounting bracket, junction 
box  

017-5300-005

MP 130 Fiber sheet, 12 x 21 058-0021-002

NP 001 Label, HHC junction box 559-5000-501

PC 001 PC board, junction box rev 
2 

035-5300-130 2

Q 001 NPN general purpose  576-0003-658

Q 002 NPN general purpose 576-0003-658

   

R 001 30k ohm ±5% 1/16W smd 569-0155-303

R 002 20k ohm ±5% 1/16W smd 569-0155-203

R 003 220k ohm ±5% 1/16W smd 569-0155-224
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R 004 39k ohm ±5% 1/16W smd 569-0155-393

R 005 62k ohm ±5% 1/16W smd 569-0155-623

R 006 62k ohm ±5% 1/16W smd 569-0155-623

R 007 10k ohm ±5% 1/16W smd 569-0155-103

R 008 1k ohm ±5% 1/16W smd 569-0155-102

R 009 2.7k ohm ±5% 1/16W smd 569-0155-272

R 010 8.2k ohm ±5% 1/16W smd 569-0155-822

R 012 20k ohm ±5% 1/16W smd 569-0155-203

R 013 30k ohm ±5% 1/16W smd 569-0155-303

R 014 20k ohm ±5% 1/16W smd 569-0155-203

R 015 20k ohm ±5% 1/16W smd 569-0155-203

R 016 20k ohm ±5% 1/16W smd 569-0155-203

R 017 220k ohm ±5% 1/16W smd 569-0155-224

R 018 20k ohm ±5% 1/16W smd 569-0155-203

R 019 39k ohm ±5% 1/16W smd 569-0155-393

R 020 62k ohm ±5% 1/16W smd 569-0155-623

R 021 20k ohm ±5% 1/16W smd 569-0155-203

R 022 62k ohm ±5% 1/16W smd 569-0155-623

R 023 20k ohm ±5% 1/16W smd 569-0155-203

R 024 20k ohm ±5% 1/16W smd 569-0155-203

R 025 20k ohm ±5% 1/16W smd 569-0155-203

R 026 200k ohm ±5% 1/16W smd 569-0155-204

R 027 20k ohm ±5% 1/16W smd 569-0155-203

R 028 20k ohm ±5% 1/16W smd 569-0155-203

R 029 20k ohm ±5% 1/16W smd 569-0155-203

R 030 20k ohm ±5% 1/16W smd 569-0155-203

R 031 20k ohm ±5% 1/16W smd 569-0155-203

R 032 300 ohm ±5% 1/16W smd 569-0155-301

R 033 300 ohm ±5% 1/16W smd 569-0155-301

R 034 20k ohm ±5% 1/16W smd 569-0155-203

R 035 20k ohm ±5% 1/16W smd 569-0155-203

R 036 20k ohm ±5% 1/16W smd 569-0155-203

R 037 100k ohm ±5% 1/16W smd 569-0155-104

R 038 20k ohm ±5% 1/16W smd 569-0155-203

R 039 20k ohm ±5% 1/16W smd 569-0155-203

R 040 20k ohm ±5% 1/16W smd 569-0155-203

R 041 100k ohm ±5% 1/16W smd 569-0155-104

R 042 20k ohm ±5% 1/16W smd 569-0155-203

R 043 20k ohm ±5% 1/16W smd 569-0155-203

R 044 20k ohm ±5% 1/16W smd 569-0155-203

R 045 100k ohm ±5% 1/16W smd 569-0155-104

R 046 20k ohm ±5% 1/16W smd 569-0155-203

R 047 100k ohm ±5% 1/16W smd 569-0155-104

R 049 150 ohm ±5% 1/16W smd 569-0115-151

R 050 10k ohm ±5% 1/16W smd 569-0155-103

R 051 10k ohm ±5% 1/16W smd 569-0155-103

   

S 001 Relay, photo MOS 1.3A 
100V 

544-1020-035

S 002 Relay, photo MOS 1.3A 
100V 

544-1020-035

   

U 001 Op amp, quad MC3303 544-2020-008

U 003 Op amp, quad MC3303 544-2020-008

U 004 Audio amp, stereo 150 
mW TPA122 

544-2006-030

U 005 Switch, bilateral 
MC14066B  

544-3016-066

U 006 Op amp, quad MC3303 544-2020-008

U 007 Comparator, dual LM2903  544-2025-009

U 009 Regulator, 5V 0.5A 78M05 544-2003-079

   

   

SIREN CONTROLLER KIT 
Part No. 250-5300-101 

A 001 Siren wire kit 023-5300-101

 (see separate listing)  

A 015 Siren system, w/ctrlr, amp, 
cable 

585-5300-015

   

Siren Wire Kit 
Part No. 023-5300-101 

F 001 Fuse, 15A 32V 534-0332-015 FH001 Fuseholder, in-line 534-1100-003
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HW001 Ring terminal, 1/4 12-16 
AWG 

586-0001-150

HW002 Solder splice terminator 
.100-.175 

586-0007-085

W 001 Wire, zip cord 14 AWG 597-2006-004

W 002 Wire, 14 AWG black 
stranded 

597-7021-400

W 003 Wire, 14 AWG red stranded 597-7021-402

   

REMOTE PROG. INTERFACE 
(RPI) 

Part No. 023-5300-000 
C 003 .1 µF ±10% X7R 50V smd  510-3606-104

C 004 .1 µF ±10% X7R 50V smd  510-3606-104

C 005 .1 µF ±10% X7R 50V smd  510-3606-104

C 010 10 µF 25V tantalum smd  510-2627-100

C 011 10 µF 25V tantalum smd  510-2627-100

C 014 4.7 µF 10V tantalum smd  510-2624-479

C 015 4.7 µF 10V tantalum smd  510-2624-479

C 016 10 µF 16V tantalum smd  510-2625-100

C 017 10 µF 16V tantalum smd  510-2625-100

C 018 10 µF 25V tantalum smd  510-2627-100

   

CR 001 Schottky diode, 1A/100V  523-0519-031

CR 002 Schottky diode, 1A/100V  523-0519-031

CR 003 Schottky diode, 1A/100V  523-0519-031

CR 004 Schottky diode, 1A/100V  523-0519-031

CR 006 Switching diode SOT-23  523-1504-002

CR 007 Switching diode SOT-23  523-1504-002

CR 008 5.6V zener SOT-23  523-2016-569

DS 001 Red/grn LED rt angle  549-4006-001

   

HW 006 Screw, TT 4-40 x .25 pan 
hd  

575-0604-008

HW 012 Polarizing key  515-7109-010

     

J 001 Jack, 3.6 mm enclosed  515-2001-011

J 002 Jack, 9-pos PC mt  515-0506-043

J 003 Jack, power PC mt  515-2007-010

J 004 Header, 10-pin shrouded  515-7104-005

J 007 Jack, 2-pin sgl in-line hdr  515-7100-002

J 008 Jack, mini enclosed  515-2002-011

     

MP 001 Extruded metal enclosure  014-0777-021

MP 002 Back panel (DB9 end)  017-2206-017

MP 003 Front panel (LED end)  017-2206-016

MP 007 Spacer, 4-40 hex 
male/female 

013-1160-103

   

NP 001 ID/nameplate  559-5000-500

PC 001 PC board  035-5300-030

   

Q 001 NPN general purpose SOT-
23  

576-0003-658

Q 005 NPN general purpose SOT-
23  

576-0003-658

     

R 009 1k ohm ±5% 1/8w SMD  569-0115-102

R 010 200 ohm ±5% 1/8W smd  569-0115-201

R 012 10k ohm ±5% 1/8W smd  569-0105-103

R 013 10k ohm ±5% 1/8W smd  569-0105-103

R 020 10k ohm ±5% 1/8W smd  569-0105-103

R 024 10k ohm ±5% 1/8W smd  569-0115-103

R 025 3k ohm ±5% 1/8W smd  569-0115-302

R 028 3k ohm ±5% 1/8W smd  569-0115-302

R 029 3k ohm ±5% 1/8W smd  569-0115-302

R 032 10k ohm ±5% 1/8W smd  569-0115-103

R 035 300 ohm ±5% 1/8W smd  569-0115-301

R 036 3k ohm ±5% 1/8W smd  569-0115-302

R 037 Zero ohm ±5% 1/8W smd  569-0115-001

R 038 10k ohm ±5% 1/8W smd  569-0105-103

R 039 10k ohm ±5% 1/8W smd  569-0115-103

R 040 10k ohm ±5% 1/8W smd  569-0115-103

R 041 100k ohm ±5% 1/8W smd  569-0115-104

     

S 009 DIP switch, 8-pos SPST  583-5100-108

     

U 001 Regulator, 5V 0.5A 78M05 544-2003-079
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U 004 RS-232 rx/tx, dual 
MAX232  

544-2023-019

U 005 RS-485 bus xcvr SN65176  544-2023-027

U 006 Schmitt trigger 74HC14  544-3766-014

 

Ref No. Description Part No. 

VHF RF BOARD 
B11 PCA, VHF, RF, TRANSCEIVER, EFJ  

E3,E4,J3,L5,L9,L12,L16,L26,L49,L82,P1,P2,P3,R7,R18,R19, 
R21,R22,R28,R29,R30,R40,R82,R85,R106,R107 

NOT PLACED NP 

C1,C10,C13,C21,C26,C36,C37,C45,C229,C232,C242,C318 NOT PLACED NP 

J2 PCB, FLEX, EFJ 0P795/D 

 PCB, VHF, RF TRANSCEIVER, EFJ 0P811/B 

CP1,CP2,CP3,CP4 CAP, 4 UP, 47 PF, ±10%, 50V, NPO, 
1206 

1C424-470 

C2,C6,C42,C43,C44,C47,C96,C97,C99,C109,C120,C121,C141, 
C164,C182,C192,C195,C285,C288,C291,C304 

CAP, CER, 0.1 UF, ±10%,10V,  X7R, 
0603 

1C455-104 

C3,C19,C55,C126,C135,C136,C142,C143,C181,C193,C194, 
C287,C292,C305 

CAP, CER, 100 PF, ±5%, NPO, 0603 1C113-101 

C4,C20,C29,C69,C101,C102,C106,C110,C111,C114,C127,C128,
C129,C130,C131,C134,C137,C140,C145,C150,C151,C152,C153,
C163,C169,C176,C189,C199,C200 

CAP, CER, 0.01 UF, ±10%, X7R, 0603 1C148-103 

C5 CAP, PPS FILM, .0047 UF, ±5%, 16V, 
LOW ESR, 0805 

1C478-472 

C7,C9 CAP, CER, 180 PF, NPO, 0603 1C113-181 

C8,C274,C303 CAP, CER, 10 PF, ±5%, NPO, 0603 1C113-100 

C11,C14,C17,C23,C24,C25,C33,C34,C46,C48,C49,C50,C61,C62,
C63,C65,C67,C70,C95,C107,C113,C118,C122,C148,C149,C155,
C156,C157,C159,C162,C165,C166,C167,C205,C206,C222,C223,
C224,C225,C226,C240,C276,C295,C296,C297,C299,C300,C301,
C307 

CAP, CER 1000 PF, ±5%, NPO, 0603 1C113-102 

C12 CAP, PPS FILM, 0.018 UF. ±5%, 16V, 
3216 

1C733-B183

C15,C298 CAP, CER, 47 PF, ±5%, NPO, 0603 1C113-470 

C16 CAP, PPS FILM, .015 UF, ±5%, 16V, 
3216 

1C478-153 

C18,C230,C234,C235,C277 CAP, CER, 39 PF, ±2%, NPO, 0603 1C731-390 

C22 CAP, PPS FILM, 0.68 UF, ±10%, 16V, 
LOW ESR, 3216 

1C478-684 

C27,C272,C273,C312,C313 CAP, CER, 3.3 PF, ±0.25 PF, 0603 1C450-3R3 

C28 CAP, FILM, 0.15 UF, ±20%, 16V, 3216 1C353-J154
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C30,C293 CAP, PPS FILM, 0.22 UF, ±10%, 25V, 
LOW ESR, 3216 

1C478-224 

C31,C139 CAP, CER, 200 PF, ±5%, NPO, 0603 1C113-201 

C32 CAP, TANT, 4.7 UF, ±20%, 16V, B 
CASE 

1C166-475 

C35,C125,C132,C133,C168,C171,C174,C175,C202,C203,C286,
C289,C290,C302 

CAP, TANT, 4.7 UF, ±20%, 16V,  A 
CASE 

1C573-A475

C38,C115 CAP, CER, 33 PF, ±5%, NPO, 0603 1C113-330 

C39 CAP, CER, 8.2 PF, ±0.25 PF, 0603 1C450-8R2 

C40 CAP, CER, 1.0 PF, ±0.1 PF, NPO, 0603 1C731-1R0 

C41,C90,C294 CAP, CER, 470 PF, ±5%, NPO, 0603 1C113-471 

C51,C72 CAP, CER, 22 PF, ±5%, LOW E, NPO, 
0603 

1C731-220 

C56 CAP, CHIP, 1.0 UF, ±20%, 10V, X7R, 
0603 PKG 

73550 

C60 CAP, CER, 18 PF, ±5%, NPO, 0603 1C113-180 

C64 CAP, CER, 15 PF, ±2%, LOW ESR, 
HIGH-Q, 0603 

1C731-150 

C68,C241 CAP, CER, 12 PF, ±5%, NPO, 0603 PKG 1C113-120 

C89 CAP, CER, 5.6 PF, ±0.25 PF, 0603 1C450-5R6 

C98,C123,C154,C284 CAP, TANT, 10 UF, ±20%, 10V, A 
CASE 

1C117-106 

C100,C108,C112,C116,C117 CAP, CER, 56 PF, ±5%, NPO, 0603 1C113-560 

C103 CAP, CER, 0.012 UF, ±5%, 50V, X7R, 
0805 

1C399-123 

C104,C160,C311 CAP, CER, 4700 PF, ±10%, X7R, 0603 1C148-472 

C105,C146,C147,C161,C172,C177,C196,C310 CAP, TANT, 1.0 UF, ±20%, 16V, A 
CASE 

1C118-105 

C119,C236,C237 CAP, CER, 82 PF, ±2%, LOW ESR, HI-
Q,  0603 

1C731-820 

C138 CAP, CER, 0.022 UF, ±10%, 50V, X7R, 
0805 

1C143-223 

C144 CAP, CER, 2200 PF, ±10%, X7R, 0603 1C148-222 

C158 CAP, CER, 120 PF, ±5%, NPO, 0603 1C113-121 

C210 CAP, CER, 82000 PF, ±10%, X7R, 0603 1C148-823 

C231,C233,C238,C239 CAP, CER, 6.2 PF, ±0.1 PF, LOW ESR, 
HI-Q, 0603 

1C731-6R2 

C270 CAP, CER, 2.7 PF, ±0.25 PF, NPO, 0603 1C113-2R7 

C271 CAP, CER, 6.8 PF, ±0.1 PF, LOW ESR, 
HI-Q, 0603 

1C731-6R8 
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C306 CAP, FILM CHIP, 1200 PF, ±5%, 16V, 
0805 

73697 

C308 CAP, FILM CHIP, 4700 PF, ±5%, 16V, 
0805 

73699 

C309 CAP, FILM CHIP, 3300 PF, ±5%, 16V, 
0805 

73698 

D4,D10 TRANS, MOSFET, P-CH, SOT23 1T158-
SI2323 

D9 DIODE, SILICON, TUNING, SOT23, 
MV2105   

72672 

D12,D13 DIODE, PIN, HIGH AVG POWER 
SMQ, MELF 

72663 

EC1 SHIELD,COVER, IF LARGE 3M797-2 

EC2 SHIELD, COVER, IF SMALL 3M809-2 

EC5 SHIELD, COVER, PLL 3M813-2 

EC7 SHIELD, POWER AMPLIFIER 3M800 

EC9 CLIP, GROUND, 3638001000 72673 

EC10 CLIP, SPRINGS, 97-251-02 72674 

E1 SHIELD, FENCE, IF LARGE 3M797-1 

E2 SHIELD, FENCE, IF SMALL 3M809-1 

E5 SHIELD, FENCE, PLL 3M813-1 

FB1,FB2,FB3 INDUCTOR, FERRITE LEAD, SMT, 
0121 

1L137-
1210S0 

FB4,FB5,FB6,FB7,FB8,FB9,FB10 INDUCTOR, FERRITE BEAD, SMT, 
0805 

1L137-3 

F1 FUSE, FAST-ACTING, 2A, SMT, 0603 1X619-2R0 

J1 CONN, COAX PLUG, SMT 1J607-2 

L1,L2,L7 INDUCTOR, 270 NH, ±2%, SMT, 1008 1L498-271 

L3 INDUCTOR, 68 NH, ±10%, SMT, 1008 1L190-680 

L4 INDUCTOR, 390 NH, ±5%, SMT, 0603 1L177-391 

L6,L8 INDTR, 12 NH, ±2%, SMT, 0603 1L177-120G

L10,L33 INDTR, 120 NH, ±2%, SMT, 0603 1L177-121G

L11,L21,L22 INDTR, CHIP, 51 NH, ±2%, HIGH-Q, 
0805 

78261 

L19,L32,L36 INDTR, 180 NH, ±2%, SMT, 0603 1L177-181G

L27 INDTR, CHIP, 180 NH, ±2%, 1008 PKG 78126 

L28 INDUCTOR, 150 UH, ±10%, 1210 1L514-154 

L29,L30 INDUCTOR, WIREWOUND, 10 UH, 
1206 

1L575-102 

L31 INDUCTOR, 220 NH, ±10%, SMT, 1008 1L190-221 
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L35 INDUCTOR, 39 NH, ±5%, SMT, 0603 1L177-390 

L40 INDUCTOR, 100 NH, ±5%, SMT, 0603 1L177-101 

L44 INDUCTOR, 82 NH, ±5%, SMT, 0603 1L177-820 

L46,L47,L48 INDTR, CHIP, 470 NH, 5%, 0603LS 1L835-471 

L50,L51,L53,L54 INDTR, 150 NH, ±2%, SMT, 1008  
(REFERENCE 78127) 

1L498-151 

L77,L78 INDTR, 72 NH, ±2%, SMT, 0603 1L177-720G

L81 INDUCTOR, 330 NH, ±5%, SMT, 0603 1L177-331 

MX1 MIXER, 100-500 MHZ, 7 DB CL,  5 
DBM LO 

72668 

P4,P5,P6,P7,P8 SPRING CONTACT,ELECTRICAL 3C799 

Q1,Q2 TRANSISTOR, SMT, NPN, SS RF, 
SOT-2 

1T153-941 

Q3,Q4,Q5,Q6,Q7 TRANSISTOR, MOSFET, RDSO, SOT-
23 

1T159-
7002CT 

RP1 RES, ARRAY, 1K X 4, SMT 1R230-102 

R1 RES, 18K, ±5%, SMT, 0603 1R105-183 

R2,R6 RES, 560 OHM, ±5%, SMT, 0603 1R105-561 

R3 RES, 12K OHM, ±5%, SMT, 0603 1R105-123 

R4,R62,R64 RES, 120 OHM, ±5%, SMT, 0603 1R105-121 

R5,R8,R109 RES, 620 OHM, ±5%, SMT, 0603 1R105-621 

R9 RES, CHIP, 390K OHM, ±5%, 0603 
PKG 

75886 

R10,R113 RES, 240 OHM, ±5%, SMT, 0603 1R105-241 

R11,R15,R43,R52,R59,R98 RES, 1.0K OHM, ±5%, SMT, 0603 1R105-102 

R12,R14,R32,R42,R58,R69,R76,R102,R103 RES, 10K OHM, ±5%, SMT, 0603 1R105-103 

R13 RES, 30 OHM, ±5%, SMT, 0603 1R105-300 

R16 RES, CHIP, 12 OHM, ±5%, 0603 PKG 75476 

R17 RES, 200 OHM, ±5%, SMT, 0603 1R105-201 

R20,R45,R57,R60,R79,R83,R84,R86,R87,R88,R108,R124,R125,
R126,R130 

RES, 0 OHM, ±5%, SMT, 0603 1R105-0R0 

R23,R48,R70,R116 RES, 51 OHM, ±5%, SMT, 0603 1R105-510 

R24,R33,R34,R35,R73,R74,R77,R78,R81,R111,R112,R114,R115 RES, 330 OHM, ±5%, SMT, 0603 1R105-331 

R25,R27 RES, 470 OHM, ±5%, SMT, 0603 1R105-471 

R26 RES, 10 OHM, ±5%, SMT, 0603 1R105-100 

R31 RES, 160 OHM, ±5%, SMT, 0603 1R105-161 

R36,R117 RES, 2.7K, ±5%, SMT, 0603 1R105-272 

R37 RES, 22K OHM, ±5%, SMT, 0603 1R105-223 
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R38 RES, 6.2K, ±5%, SMT, 0603 1R105-622 

R39 RES, 36K, ±5%, SMT, 0603 1R105-363 

R41 RES, 15K, ±5%, SMT, 0603 1R105-153 

R44 RES, 3K OHM, ±5%, SMT, 0603 1R105-302 

R46,R54 RES, 220 OHM, ±5%, SMT, 0603 1R105-221 

R47,R49,R71,R119 RES, 100 OHM, ±5%, SMT, 0603 1R105-101 

R50 RES, 24 OHM, ±5%, SMT, 0603 1R105-240 

R51 RES, 3.9K OHM, ±5%, SMT, 0603   1R105-392 

R53 RES, 4K OHM, ±5%, SMT, 0603 1R105-473 

R55,R61 RES, 100K OHM, ±5%, SMT, 0603 1R105-104 

R56 RES, 1.0M OHM, ±5%, SMT, 0603 1R105-105 

R63,R65,R66,R67 RES, 75 OHM, ±5%, SMT, 0603 1R105-750 

R68 RES, 9.1 OHM, ±5%, SMT, 1206 1R103-9R1 

R72 RES, 62 OHM, ±5%, SMT, 0603 1R105-620 

R80 RES, 18 OHM, ±5%, SMT, 0603 1R105-180 

R99,R100,R101 RES, 390 OHM, ±5%, SMT, 0603 1R105-391 

R104,R105 RES, 4.7K OHM, ±5%, SMT, 0603 1R105-472 

R110 RES, 270K OHM, ±5%, SMT, 0603 1R105-274 

R118 RES, CHIP, 82 OHM, 5%, 0603 75449 

R121,R122 RES, CHIP, 1.6K OHM, ±1%, 0603 75885 

R123 RES, 2.0K OHM, ±5%, SMT, 0603 1R105-202 

U1 VCO, 200-239 MHZ, UMZ-1154-D16 4V510-11 

U2,U25 CRYSTAL, 64.455 MHZ, SMT 1Y496-4 

U3 MODULE RF AMP, 135-175MHZ, 
6.5W 

1Q129-
RA07M 

U6 IC, RF AMP, 150-2500 MHZ, GAAS 
HBT 

1Q129-
RF2361 

U7 SWITCH, PHEMT, SPDT, DC-2.5 GHZ, 
AS169-73 

71728 

U9 IC, TEMP SENSOR, -40 TO +125, SOT 1Q126-
LM50B1Z 

U10,U27,U34 IC, REG, LOW DROP OUT, 5.0V, SMT, 
SO 

1Q127-7081-
50 

U11 IC, IF DIGITIZING SUB-SYSTEM, SM 1Q130-9864

U12,U13 IC, REG, LOW DROP OUT, 3.3V, SMT, 
SO 

1Q127-7081-
33 

U14,U15 IC, CMOS, SCHMMIT INVERTER, 
SINGLE 

1Q128-
74V1G14S 


